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Important Safety Instructions 
 
1. Installing and operating your Zapex Encoder. 
2. Retain this User’s Guide for future reference. 
3. The Zapex Encoder operates as software and hardware that is installed inside a personal 

computer. Read these safety instructions before connecting computer to a power supply as 
described by its manual or as marked on the computer. 

4. Carefully read and adhere to special symbols and associated statements that accompany the 
operating instructions described in this User’s Guide. The following special symbols are used in 
this manual: 

 
 

 SAFETY 
In this User’s Guide the electrostatic discharge hazard symbol warns of 
static electricity safe guards. Static electricity can damage your Zapex 
Encoder. Before opening the anti-static bag that contains the encoder, 
assure your PC is turned off, then ground yourself by touching any 
exposed metal on your PC chassis or connector brackets while the 
computer is plugged in. Avoid simultaneously touching components of 
your encoder and any monitor, even if the monitor is turned off. Some 
monitors build up and retain a static charge that could damage your 
encoder. 
 

  
 ATTENTION 

The use of this symbol serves as a procedural notice. Read before 
proceeding. 
 

  
  

IMPORTANT 
This symbol provides the user important information to be aware of. 
 

  
  

NOTE 
These notes provide additional subject information. 
 

  
 

5. Appendix E provides statements for all applicable regulatory approvals. 
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Preface 

Thank you for purchasing the Zapex ZP-230 or ZP-330 Encoding System for MPEG-2 video, 
Dolby® Digital, MPEG, and PCM audio encoding. 

This User’s Guide describes precautions, specifications, connections, parameters and 
commands for using your ZP-230 or ZP-330 encoder. Please read carefully through this 
User’s Guide. It describes how to correctly operate your encoder. 

Changes for Version 4.0 
Your Zapex ZP-230 or ZP-330 Encoding System now includes the following features: 

� Program Stream Multiplex using ZP-Controller 

� Program Stream Multiplex using Adobe Premiere Plug-In or AVI files 

� Transport Stream Multiplex using ZP-Controller 

Video + Audio 

or 

Video + Audio 1 + Audio 2 

Encoded output format on each model. 

ENCODER OUTPUT MODEL 
REAL-TIME OFF-LINE 

ZP-230 and ZP-330DD 
ZP-230 and ZP-330CD 
ZP-230 and ZP-330CA 
ZP-230 and ZP-330SA 

ES, VOB, PS, TS ES, VOB, PS 

ZP-230 and ZP-330NN N/A ES, VOB, PS 
 
These are explained in detail in Chapter 1, “System Overview and Requirements.” 
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Special Note Concerning Use of Dolby® Digital Trademark 
Dolby Laboratories encourages use of the Dolby® Digital trademark to identify soundtracks 
that are encoded in Dolby® Digital. This is an effective way to inform listeners of the 
soundtrack format, and the use of a standard logo promotes easy recognition in the 
marketplace. However, like any trademark, the Dolby® Digital logo may not be used 
without permission. Dolby Laboratories therefore provides a standard trademark license 
agreement for companies who wish to use Dolby trademarks. This agreement should be 
signed by the company that owns the program material being produced. Recording studios 
or production facilities which provide audio production or encoding services for outside 
clients generally do not require a trademark license. If you would like more information on 
obtaining a Dolby trademark license, please contact Dolby Laboratories Licensing 
Corporation. Information on trademark licensing plus instructions for using the Dolby® 
Digital trademark and marking audio formats can also be found on-line at 
http://www.dolby.com. See Appendix F, “Use of Dolby Trademarks,” for more information. 
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C H A P T E R  

11  
SYSTEM OVERVIEW AND REQUIREMENTS 
This chapter contains the following information: 

9 Product Inventory 
9 System Components 

� Zapex Encoder Board Models 
� ZP-Controller Software 
� Media Cable 
� RS-232C/RS-422 Converter and VTR Control Cable  
� User’s Guide 
� Audio Level Converter 

9 System Requirements 
9 Real-Time and Off-Line Encoding 

� Real-Time Encoding 
� Off-Line Encoding 



2 ZP-330 & ZP-230 User’s Guide  —  Encoding Solutions for Digital Professionals 

1.1 PRODUCT INVENTORY 
Check the contents of the shipping container to ensure that all components of your new 
encoding system are included. Figure 1-1 shows all of the components available for the 
Zapex encoders. The model number, serial number, and options are indicated on the side 
of the shipping container. 

The NN encoder models do not contain the Media Cable, RS-232C/RS-422 Converter, 
VTR Control Cable, or Audio Level Converter. 

Figure 1-1. Inventory of Shipped Components 
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1.2 SYSTEM COMPONENTS 
This section describes the components that make up your new Zapex encoding system. 
Depending on the encoder model purchased, some components may not be included. 

1.2.1 ZAPEX ENCODER BOARD MODELS 
The encoder is a full-length board that fits into a Peripheral Component Interface (PCI) slot 
of a personal computer. It is specially designed to accept audio and video data from a 
Video Tape Recorder (VTR) or computer hard drive. It can encode source video into the 
following types: 

� Program Stream (PS) (video + audio) 

� Transport Stream (TS) (video + audio) 

� VOB (DVD Video Object) 

(or) 

� MPEG-2 Video Elementary Stream (ES) 

(and either) 

� Dolby® Digital, MPEG Layer 2 or PCM Audio Elementary Stream 

See Table 1-1 and Table 1-2.  

 

Table 1-1. ZP-230 Encoder Models 
 EXTERNAL INPUT CONNECTIONS ENCODED OUTPUT 

MODEL VIDEO AUDIO TIME CODE  VIDEO AUDIO SYSTEM 

ZP-230DD D1 Serial Digital LTC MPEG-2 PCM, MPEG Layer 2 VOB, 
PS, TS 

ZP-230CD Component (Y, R-Y, B-Y) Digital LTC MPEG-2 PCM, MPEG Layer 2 VOB, 
PS, TS 

ZP-230CA* Component (Y, R-Y, B-Y)/ S-Video Analog (L, R) LTC MPEG-2 PCM, MPEG Layer 2 VOB, 
PS, TS 

ZP-230SA S-Video Analog (L, R) LTC MPEG-2 PCM, MPEG Layer 2 VOB, 
PS, TS 

ZP-230NN N/A** N/A** N/A** MPEG-2 PCM, MPEG Layer 2 VOB, 
PS 

* Includes Audio Level Converter 
** The base ZP-230NN has no external physical connector for accepting video, audio, and time-code. It only accepts video 

and audio files stored on a hard drive. 
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Table 1-2. ZP-330 Encoder Models 
 EXTERNAL INPUT CONNECTIONS ENCODED OUTPUT 

MODEL VIDEO AUDIO TIME CODE  VIDEO AUDIO SYSTEM 

ZP-330DD D1 Serial Digital LTC MPEG-2 PCM or Dolby® Digital, 
MPEG Layer 2 

VOB, 
PS, TS 

ZP-330CD Component (Y, R-Y, B-Y) Digital LTC MPEG-2 PCM or Dolby® Digital, 
MPEG Layer 2 

VOB, 
PS, TS 

ZP-330CA* Component (Y, R-Y, B-Y)/ S-Video Analog (L, R) LTC MPEG-2 PCM or Dolby® Digital, 
MPEG Layer 2 

VOB, 
PS, TS 

ZP-330SA S-Video Analog (L, R) LTC MPEG-2 PCM or Dolby® Digital, 
MPEG Layer 2 

VOB, 
PS, TS 

ZP-330NN N/A** N/A** N/A** MPEG-2 PCM or Dolby® Digital, 
MPEG Layer 2 

VOB, 
PS 

* Includes Audio Level Converter 
** The base ZP-330NN has no external physical connector for accepting video, audio, and time-code. It only accepts video 

and audio files stored on a hard drive. 

1.2.2 ZP-CONTROLLER SOFTWARE 
The ZP-Controller software controls the audio and video encoding parameters. It is 
required that this software be installed on your computer hard drive. 

The ZP-Scheduler software performs sequential real-time encoding sessions. 

The ZP-Decker software remotely controls a VTR. 

1.2.3 MEDIA CABLE 
A media cable is supplied with every encoder model except the NN models. It is used to 
connect the encoder to a VTR and/or audio player. Since encoder models vary in the type 
of external input connections they can accept, the supplied cable is unique to a model and 
is not interchangeable with other models. 

The cable is 20 inches long. One end has a single connector that fastens to the encoder, 
and the other end has 3 to 6 connectors that connect to the VTR. Each connector is 
identified with a label that matches the connectors on the VTR. 

1.2.4 RS-232C/RS-422 CONVERTER AND VTR CONTROL CABLE 
The RS-232C/RS-422 Converter and VTR Control Cable are used to connect a VTR to 
your personal computer. ZP-Controller can remotely control a VTR if the VTR has RS-422 
interface protocol control function. The Zapex encoder (models DD,CD, CA, and SA) canls 
can remotely control a VTR for frame accurate encoding. 
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1.2.5 USER’S GUIDE 
This Zapex User’s Guide covers using and installing the Zapex Encoding solutions. 

1.2.6 AUDIO LEVEL CONVERTER 
The Audio Level Converter is a third-party hardware product providing a dual, bi-directional 
buffer amplifier designed to provide level and impedance matching between consumer hi-fi 
equipment and professional, as well as industrial, audio systems. Many consumer 
electronic devices can be very useful in the professional environment, but interconnection 
is difficult due to differences in operating levels, impedances, and unbalanced line 
operation. The Audio Level Converter solves these problems through its simple, high-
quality interface design without the added noise, distortion and instability that can result 
from an improper hookup. 

The Audio Level Converter provides exceptionally wide bandwidth and dynamic range, 
flawless square wave response, good common-mode rejection and low distortion. It is 
ideal for interfacing with the new digital disc and tape machines in the studio. Other 
consumer devices that may be used in the professional environment are video cassette 
recorder, audio cassette recorders, graphic equalizers, reverb and ambience devices, 
noise reduction systems, electronic crossovers and power amplifiers. 

1.3 SYSTEM REQUIREMENTS 
The Zapex encoder must be installed in a personal computer. The minimum system 
configuration for the computer is listed below. 

� Pentium II 266 MHz processor (Pentium II 350 MHz or higher processor is 
recommended) 

� An available full-length PCI slot 

� 64 megabytes (MB) of RAM. (128 MB is recommended) 

� Two hard disk drives are required: 

One hard drive must be used as a system disk drive with 2 MB of free space for 
the ZP-Controller software 

One hard drive must be used for storing the encoded capture files (Ultra-Wide 
SCSI disk drive, formatted in the Windows NT file system (NTFS) 

� Microsoft Windows® NT operating system version 4.0 

� Windows NT Service Pack 3 or higher 
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1.4 REAL-TIME AND OFF-LINE ENCODING 
The following is a brief explanation of the difference between Real-Time and Off-Line 
encoding. Chapters 3 and 4 provide specific information on how to configure and start an  
encoding session for each encoding method. 

1.4.1 REAL-TIME ENCODING 

 

Real-Time Encoding cannot be performed with the ZP-230NN and ZP-330NN 
encoders. 

 

Real-Time Encoding is the capture and encoding of content as it is being played from a 
tape or video capture source such as a video camera. Real-Time Encoding usually 
involves using a VTR (Video Tape Recorder) for the playback of the content you want to 
encode. The video is referred to as the source video. The encoder receives the source 
video and/or audio, then encodes it based upon the encoding parameters configured in the 
ZP-Controller software. 

The encoding process creates output files and saves them to a hard disk. These output 
files contain the actual encoded video and audio source. Output files are sometimes 
referred to as streams. 

Depending on how the ZP-Controller is configured, a single encoding session can encode 
a source video into a PS (Program Stream), a TS (Transport Stream), a VOB (DVD Video 
Object), an ES (MPEG-2 Video Elementary Stream), and/or a Dolby® Digital, MPEG Layer 
2, or PCM Audio Elementary Stream (depending on the encoder model). VOBs contain 
both the encoded video and audio streams that can be viewed with a DVD decoder. DVD 
authoring software uses both video and audio elementary streams to create final DVD 
titles. 

1.4.2 OFF-LINE ENCODING 
Off-Line encoding involves opening one or more source files located on a hard disk, then 
encoding them. In this method, a video/audio capture card is used to transfer the source 
material from a VTR to the hard disk. There are two kinds of Off-Line encoding. One that 
can be performed from the ZP-Controller main window (see Chapter 4, “Off-Line 
Encoding”), and the other that can be done within Adobe Premiere (see Chapter 5, “Off-
Line Encoding Using Adobe® Premiere®” for instructions). 

The Off-Line encoding modes produce the same types of output files as the Real-Time 
encoding mode. Depending on the content and system configuration, Off-Line encoding 
may require more time than a Real-Time encoding. 
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C H A P T E R  

22  
HARDWARE AND SOFTWARE INSTALLATION 
This chapter contains the following information: 

9 Installation Overview 
9 What is Needed to Install the Zapex Encoder 
9 Installing the Zapex Encoder 
9 Connecting the Media Cable and VTR Control Cable 
9 Zapex Software Installation 
9 Configuring the Drastic RS-422 VCR Control 
9 Configuring the ZP-Controller Properties Dialog Box 
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2.0 HARDWARE AND SOFTWARE INSTALLATION 
This chapter provides the information that you will need to install your Zapex Encoder. 

2.1 INSTALLATION OVERVIEW 
The following installation procedures must be performed to install your Zapex encoding 
system. Each procedure is listed below and described in detail in the following sections. 

� Installing the Zapex Encoder 

� Connecting the Media Cable and VTR Control Cable 

� Installing the Zapex software 

� Configuring the Drastic RS-422 VCR Control 

� Configuring the ZP-CONTROLLER Properties dialog box 

If you have questions during the installation process, technical support is available from 
your local dealer or distributor. 

2.2 WHAT IS NEEDED TO INSTALL THE ZAPEX ENCODER 
1. A screwdriver. 

2. Your computer Owner's Manual. 

3. Your VTR Owner's Manual. 

4. An available internal power connector. This is the same type of power connector that is used 
for a hard drive or CD-ROM drive. 

 

If an internal power connector is not available, a Y-connector can be 
purchased from a local electronics supplier. 

5. An available COM port for the VTR Control Cable. 

6. A VTR that supports RS-422 remote control. 
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7. Appropriate video and audio cables to connect the VTR to the Zapex encoder. Please refer 
to the VTR Owner’s Manual for VTR connector specifications. 

SA Models 

� One S-Video cable 

� One Time-Code (LTC) cable with a male BNC connector  

� Two Audio cables with male BNC connectors for unbalanced input 

Additional Items (Provided By Customer) 

� One “Y” power cable adapter (10-inch minimum) 

� Two BNC to RCA connector adapters 

CA Models 

� Three Video cables with male BNC connectors 

� One Time-Code (LTC) cable with a male BNC connector 

� Two Audio cables with male BNC connectors for unbalanced input 

� Four Audio cables: two balanced audio cables with male XLR connectors, and 
two unbalanced audio cables with male RCA to male BNC connectors for 
balanced input 

� One S-Video cable 

Additional Items (Provided By Customer) 

� One “Y” power cable adapter (10-inch minimum) 

� Two BNC to RCA connector adapters 

CD Models 

� Three Video cables with male BNC connectors 

� One Time-Code (LTC) cable with a male BNC connector 

� One Digital Audio cable with a male BNC connector  

Additional Items Provided By Customer 

� One “Y” power cable adapter (10-inch minimum) 

� One BNC to XLR adapter (passive converter unbalanced to balanced audio) 

� One BNC to XLR (straight through) adapter 



10 ZP-330 & ZP-230 User’s Guide  —  Encoding Solutions for Digital Professionals 

DD Models 

� One Digital Video cable with a male BNC connector 

� One Time-Code (LTC) cable with a male BNC connector 

� One Digital Audio cable with a male BNC connector 

Additional Items Provided By Customer 

� One “Y” power cable adapter (10-inch minimum) 

� One BNC to XLR adapter (passive converter unbalanced to balanced audio) 

� One BNC to XLR (straight through) adapter 
8. Adobe Premiere 5.0 (or higher), if you are planning to use the Adobe Premiere plug-in.  

Premiere must be installed before installing the ZP-Controller software. 

2.3 INSTALLING THE ZAPEX ENCODER 
The Zapex encoders are full-length PCI boards designed to be installed in most personal 
computers (PC). 

 

ELECTROSTATIC DISCHARGE: Static electricity can damage your 
Zapex Encoder. Before opening the anti-static bag that contains the encoder, 
assure your computer is turned off, then ground yourself by touching any 
exposed metal on the computer chassis or connector brackets while the 
computer is plugged in. Avoid simultaneously touching components of your 
encoder and any monitor, even if the monitor is turned off. Some monitors 
build up and retain a static charge that could damage your encoder. 

 ZAPEX ENCODER INSTALLATION 

1. Turn off the computer and disconnect it from any power source. 

2. Disconnect all external devices from the computer. 

3. Remove the cover from your computer to access a PCI slot. For detailed instructions, refer to 
your computer hardware manual. 

4. Unscrew and remove the metal filler plate from the selected PCI expansion slot. 

5. Insert the Zapex encoder into the available PCI slot. Make sure that the board is firmly 
seated. 

6. Secure the encoder board to the slot with the screw removed in step 4. 
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7. Connect an internal power cable from the computer’s power supply to the main board of the 
encoder. Refer to Figure 2-1. 

 

The computer should have an available internal power cable that can be 
plugged directly into the power connector on the encoder board. This is the 
same type of cable used for connecting power to a hard drive or CD-ROM 
drive. 

Figure 2-1. Encoder Internal Power Connection 

 

 
8. Replace the computer cover as described by its manual. 

9. Connect external devices. 
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2.4 CONNECTING THE MEDIA CABLE AND VTR 
CONTROL CABLE 

If you have models ZP-330NN or ZP-230NN, you can skip this section because a VTR can 
not be connected to these models. Only the DD, CD, CA, and SA models can be 
connected to, and remotely control a VTR. The Media Cable is specific to your encoder 
model and can not be used on other encoder models. 

 CONNECTING THE MEDIA CABLE TO THE ENCODER 

 

IMPORTANT: Before attempting any cable connections, make sure all 
units involved in your system are off. 

1. The media cable has a large single connector on one end. Attach this to the connector on the 
encoder. Refer to Figure 2-2. 

Figure 2-2. The Media Cable 

 

 
2. Secure the connection by tightening the screws. 

 

To do frame accurate encoding the VTR's Time-Code Out needs to be 
connected to the LTCIN connector on the Media Cable.  

For references to connections made to the VTR, refer the VTR Owner's 
Manual for details. 
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3. Select the appropriate encoder model from the list below, and follow the instructions for that 
model: 

� SA Model Encoders 

� CA Model Encoders 

� CD Model Encoders 

� DD Model Encoders 

 

SA Models 

The SA cable has four connectors: S-Video for video, AAUD-L and AAUD-R for analog audio 
(female BNC), and LTCIN for time code input (female BNC). 

Video 
Connect one end of the S-Video cable to the S-Video out of the Zapex Media Cable. 
Connect the other end to the S-Video connector on the VTR. 

Time Code 
Connect the male BNC connector of the Time Code cable to the LTCIN connector of 
the Zapex Media Cable. Connect the other end to the Time Code out on the VTR. 

Audio 
Connect the male BNC connectors of the Unbalanced audio cables to the AAUD-L 
and AAUD-R connectors of the Zapex Media Cable. Connect the other ends of these 
cables to the VTR's left and right audio outputs. 

CA Models 

The CA cable has seven connectors: Y, CR, and CB for Video (female BNC); C for the 
S-video adapter (female BNC); AAUD-L and AAUD-R for analog audio (female BNC); LTCIN 
for time code input (female BNC). The S-Video adapter is a special connector that connects 
to the Y-connector and C-connector to create an S-Video input option on the CA model 
encoders. 

Video 
a) Connect the male BNC connector of the Y-video cable to the Y-connector of the 

Zapex Media cable. Connect the other end of this cable to the Y-video out 
connector on the VTR. 

b) Connect the male BNC connector of the R-video cable to the CR-connector of the 
Zapex Media cable. Connect the other end of this cable to the R-video out 
connector on the VTR. 

c) Connect the male BNC connector of the B-video cable to the CB-connector of the 
Zapex Media cable. Connect the other end of this cable to the B-video out 
connector on the VTR. 
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Time-code 
Connect the male BNC end of the Time-Code cable to the LTCIN connector of the 
Zapex Media Cable. Connect the other end of this cable to the Time-Code out 
connector on the VTR. 

Audio 
a) If you are connecting to an unbalanced audio source, connect the male BNC 

connectors of the unbalanced audio cables to the AAUD-L and AAUD-R 
connectors of the Zapex Media Cable. Connect the other ends of these cables to 
the VTR's left and right audio outputs. 

b) If you are connecting to a balanced audio source, connect the male XLR 
connectors of the balanced audio cables to the Audio Level Converter. Connect 
the other ends of these cables to the VTR’s left and right audio ouput. Connect 
the male RCA connectors of the unbalanced audio cables to the Audio Converter. 
Connect the male BNC ends of these cables to the AAUD-L and AAUD-R 
connectors of the Zapex Media Cable. 

c) Interconnect cables between the Audio Level Converter and the balanced audio 
source are provided by the customer. 

CD Models 

The CD cable has six connectors: Y, CR, and CB for Video (female BNC); DAUDIN for digital 
audio (female BNC); LTCIN for time code input (female BNC). 

Video 
a) Connect the male BNC connector of the Y-video cable to the Y-connector of the 

Zapex Media cable. Connect the other end of this cable to the Y-video out 
connector on the VTR. 

b) Connect the male BNC connector of the R-video cable to the CR-connector of the 
Zapex Media cable. Connect the other end of this cable to the R-video out 
connector on the VTR. 

c) Connect the male BNC connector of the B-video cable to the CB-connector of the 
Zapex Media cable. Connect the other end of this cable to the B-video out 
connector on the VTR. 

Time-code 
Connect the male BNC connector of the Time-Code cable to the LTCIN connector of 
the Zapex Media Cable. Connect the other end of this cable to the Time-Code out 
connector on the VTR. 

Audio 
Connect the male BNC connector of the Digital audio cable to the DAUDIN connector 
of the Zapex Media Cable. Connect the other end of this cable to the Channel 1/2 
digital audio out connector on the VTR.  
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Connecting — DD Model Encoders 

The DD cable has three connectors: D1 IN serial digital Video (female BNC), DAUDIN for 
digital audio (female BNC), LTCIN for time-code input (female BNC). 

Video 
Connect the male BNC connector of the Digital video cable to the D1 IN connector of 
the Zapex Media Cable. Connect the other end of this cable to the Serial Digital video 
out connector on the VTR. 

Time-code 
Connect the male BNC connector of the Time-Code cable to the LTCIN connector of 
the Zapex Media Cable. Connect the other end of this cable to the Time Code out 
connector on the VTR. 

Audio 
Connect the male BNC connector of the Digital audio cable to the DAUDIN connector 
of the Zapex Media Cable. Connect the other end of this cable to the Channel 1/2 
digital audio out connector on the VTR. 

 CONNECTING THE RS-232C/RS-422 CONVERTER AND VTR CONTROL CABLE 

1. Connect the RS-232C side of the RS-232C/RS-422 Converter to a serial port on the 
computer (COM1 or COM2). Make sure the connector screws are snug. Refer to 
Figure 2-3. 

Figure 2-3. RS-232C/RS-422 Converter and  VTR Control Cable 

 

 
2. Connect the VTR Control Cable to the RS-422 side of the RS-232C/RS-422 Converter. 

Connect the other end to the remote control connector on the VTR. 

3. Make sure that the connector screws on both ends of the VTR Control Cable are tightened 
securely to their respective devices. 
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2.5 ZAPEX SOFTWARE INSTALLATION 
This section describes the software installation process. The software CD contains a setup 
program that checks your system with a series of questions about how to install the 
software. 

The software installation may require that the system be restarted in the middle of the 
installation process. Please close all Windows applications before installing the Zapex 
software. 

If you plan to do Off-Line Encoding using Adobe® Premiere®, then the Adobe® software 
needs to be installed prior to performing the procedures in this section. For more 
information about Off-Line Encoding, see Chapter 1, “Real-Time and Off-Line Encoding 
Described.” 

 

ATTENTION: If you use a virus protection program on your system, turn 
it off before running the setup program. The software may not work correctly if 
a virus protection program is running. After running Setup and completing the 
install, you can restart your virus protection program. 

 INSTALLING THE ZAPEX SOFTWARE 

1. Insert the Installation CD into the CD-ROM drive.  The installation CD automatically starts the 
setup program. 

2. Click Next to continue past the Welcome dialog box. 

3. Select the encoder model you are installing.  You can locate the encoder model on the 
outside of the product box, then click Next to continue. 

4. Some system configurations require a supplemental PCI configuration utility. If you are 
installing the Zapex encoder into one of the systems listed in Table 2-1, select the PCI 
Configuration Utility and click Next  to continue. 
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Table 2-1. PCI Configuration Utility Applications 
MANUFACTURER MODEL MODEL NUMBER 
Compaq Proliant 

 
 
 
Professional Workstation 
AP 

2500 
1200 
1600 
1850R 
6000 
400 
500 

Intergraph TDZ2000 Realizm2 
Tyan  Thunder 100 BX Motherboard 
Gateway  GP7-500 

 

 

IMPORTANT: If you have selected the PCI Configuration Utility for 
installation, your system will be restarted before completing the installation of 
the Zapex Controller software. Please close all open applications after the PCI 
Utility is installed. 

5. Click Finish  to continue with the installation.  If you selected the PCI Configuration Utility 
for installation, your system will be restarted before proceeding to the ZP-Controller software 
installation. 

6. Click Next to continue past the Welcome dialog box. 

7. Click Yes to agree to the license agreement. 

8. Click OK to accept the user information. 

9. Select the software components desired, and click Next to continue. Refer Table 2-2. 
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Figure 2-4. Select Components Dialog Box 

 

Table 2-2. Software Installation Component Selections 
 ITEM DESCRIPTION 

 ZP Encoder Driver  Installs communication software used by ZP-Controller. 
 ZP Encoder Control Application  Installs the ZP-Controller application. 
 
 

 

VTR Control Driver  Installs the VTR Control Driver and ZP-Decker, a tool that can remotely control a 
VTR from your computer. 
NOTE: If you are using an NN model encoder, do not select 

this component.  

 Adobe Premiere Plug-ins  Installs software which can be used for performing Off-Line encoding from inside 
Adobe® Premiere®, Version 5.x. This software must be installed prior to the Zapex 
Encoder installation in order to function correctly. 

 
10. To change the Destination Folder, click Browse and choose a new folder. 

11. Click Yes to allow the setup program to create the Zapex encoding software directory. 

12. Select the COM port the VTR control cable is connected to and click Next. 

13. Setup is now complete. Remove any disks from the drives. 

14. Select Yes, I want to restart my system now to restart your system, then click Finish. 
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2.6 CONFIGURING THE DRASTIC RS-422 VCR CONTROL 
Depending on which encoder model you have, your VTR can be remotely controlled by 
ZP-Controller. For VTR control, you must configure the Drastic RS-422 VCR Control in the 
Multimedia Control Panel. 

If you have an NN encoder model, please skip this section. 

 CONFIGURING THE DRASTIC RS-422 VCR CONTROL 

1. From the Microsoft taskbar, click Start, select Settings, then select Control Panel. 

2. Double-click the Multimedia icon and the Multimedia Properties window will appear. Refer to 
Figure 2-5. 

Figure 2-5. Multimedia Properties Window 
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3. Click the Devices tab. 

4. Expand Media Control Devices, and select [MCI] Drastic RS-422 VCR Control. 

5. Click Properties to open the MCI Drastic RS-422 VCR Control properties box. 

6. Click Settings to access the Drastic Driver Config dialog box. Refer to Figure 2-6. 

Figure 2-6. MCI Drastic RS-422 VCR Control Properties Box 

 

7. From the Drastic Driver Config dialog box, make the following selections: 

7.a From the VTR Name drop-down list, select the model of the VTR. 

 

If your VTR is not listed, select Sony Generic RS-422 Protocol. This protocol 
is supported by most VTR manufacturers. 

7.b From the COM Port drop-down list, select the COM port (serial port) the VTR Control 
Cable is attached to. 

7.c Select the Auto TC option button. 

7.d Select the Auto Edit option button. 

7.e Select the NTSC or PAL option button. 

8. Click OK to accept the changes. 
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2.7 CONFIGURING THE ZP-CONTROLLER PROPERTIES 
DIALOG BOX 

The main purpose of the ZP-Controller Properties dialog box is to configure the Zapex 
encoder. 

 CONFIGURE THE PROPERTIES DIALOG BOX 

1. Click the Start button, select Programs, then ZP-330 or ZP-230, and then click on ZP-
Controller to start ZP-Controller. 

2. From the Options menu, select Properties to open the Properties dialog box. Refer to 
Figure 2-7. 

Figure 2-7. Properties Dialog Box 

 
 

3. To configure the Properties dialog box, refer to Table 2-3. When finished, click OK to accept 
the changes. 
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Table 2-3. Properties Dialog Box Options  
ITEM  DESCRIPTION 

Default Video File Extension  If a filename extension is omitted when naming your video output file, the extension defaults 
to the extension selected here. 
Usually the M2V, VBS, MPG, and MP2 are used by DVD authoring software. You can select 
an appropriate filename extension based on your DVD authoring and/or MPEG-2 decoding 
environment. Although the extensions are different, the encoded stream always meets the 
MPEG-2 standard. 

Allow VOB file over 1GByte  Select this check box if you are capturing VOB files over 1 Gigabyte. 
Embed Time-Code in the Dolby 
Digital file 

 Deselect this check box if you do not want to embed time-code in the Dolby® Digital file. 

VTR Control  Select this check box if you want ZP-Controller to remotely control the VTR during an 
encoding session (requires that the VTR Control Cable be installed). This feature is not 
available with the ZP-230NN or ZP-330NN encoders. 

NTSC  Select if encoding video sources recorded in the NTSC format. 
PAL  Select if encoding video sources recorded in the PAL format. 
Save Encoding Information File  Select if you want to save an Encoding Information File. This function is only available if TS is 

selected. 

 

INFORMATION FILE (TS ONLY) 
If this check box is selected, the information file for capture stream is made automatically. The information file 
is saved into the same directory that is specified for the output TS file directory.  This information file includes: 

• VideoNumber: 000000000 • Resolution: 000000000 

• Checksum: 000000000 • Composition: 000000000 

• DataType: • FrameRate: 000000000 

• VideoFrame: 000001500 • CreateDate: 06/30/2000 11:39:47AM 

• Title: test1 • ExpireDate: 

• SpotID: test1 • AudioFrames: 000000000 

• Bitrate: 4000000 • VCodeID: 

• Seconds: 000000060 • MarkIn: 00:00:00:00 

• Format: 000000000 • ExpectedVideoFrames: 000000000 
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C H A P T E R  

33  
REAL-TIME ENCODING 
This chapter contains the following information: 
9 Starting ZP-Controller 
9 Encoding Session — Configuring The ZP-Controller 
9 The ZP-Controller Main Window 
9 The Encode Process 

� Manual Encoding 
� Duration Based Encoding 
� Time-Code Encoding With VTR Control 
� Time-Code Encoding Without VTR Control 

9 Encoding Window for Multi-Audio TS Output 
9 Saving Your Work as a Project File 
9 Default Encoding and Control Values 
9 Opening an Existing Project File 
9 Updating an Existing Project File 
9 Quitting ZP-Controller 
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3.0 REAL-TIME ENCODING 
This chapter describes the ZP-Controller main window and explains how to perform 
Real-Time encoding. 

3.1 STARTING ZP-CONTROLLER 
 TO START ZP-CONTROLLER 

Click the Windows Start button, click Programs, click ZP-230 or ZP-330, select 
ZP-Controller. 

3.2 ENCODING SESSION — CONFIGURING THE 
ZP-CONTROLLER  

This section provides steps to configure the ZP-Controller software for an encoding 
session. For additional information about the encoding parameters discussed in this 
section, see the following topics. 

� Chapter 2, “Hardware and Software Installation” 

� Appendix A, “Advanced Video Encoding Parameters” 

� Appendix B, “Dolby® Digital Encoding Parameters” 

� Appendix C, “MPEG Audio Encoding Parameters” 

� Appendix D, “Advanced System Parameters” 

 
Depending on the model you have, some features may not be available. 

3.3 THE ZP-CONTROLLER MAIN WINDOW 
When you start ZP-Controller, the main window appears. Figure 3-1 shows a detail of this 
main window. 
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Figure 3-1. ZP-Controller Main Window 

 

 CONFIGURING ZP-CONTROLLER (DETAILED) 

1. Configuring the Input Parameters. 

Input parameters provide the encoder information about the source video to be encoded. 

FRAME TYPE 

 

Use the Input Frame Type drop-down list for selecting the type of time-code used by the 
source video. The NTSC video frame is the standard used in the United States and Japan. 
It has a rate of 29.97 frames per second. A video recorded with NTSC Non-Drop frame is 
more common in the United States than NTSC Drop frame. The PAL video format is the 
standard used throughout Europe and Asia. It has a frame rate of 25 frames per second. 
Input frame types that can be selected are described in the following options table. 



26 ZP-230 & ZP-330 User’s Guide  —  Encoding Solutions for Digital Professionals 

 

 

The Input Frame Type parameter does not have to be configured when you 
select Manual as the start method. 

 

INPUT FRAME TYPE SELECTION OPTIONS 
OPTION DESCRIPTION 
NTSC (29.97 fps) Non-Drop Choose for source videos recorded with non-drop time-code. 
NTSC (29.97 fps) Drop Choose for source videos recorded with drop time-code. 
PAL (25 fps) Choose for source videos recorded in PAL format. 

NOTE: Use the Properties dialog box to switch to PAL 
mode. 

 

ADVANCED [INPUT] BUTTON 
This button is only available on the CD, CA, and SA encoder models. See Appendix A, 
section A.2, “Advanced [Input] Button” for more information. 

2. Configuring the Output Parameters: 

Output parameters determine the type of (encoded) output files that are produced. 

 

FORMAT 
Use the Output Format drop-down list for choosing VOB, MPEG-2 Video Elementary 
Streams (Video ES), Program Streams (PS), or Transport Streams (TS) and/or Dolby® 
Digital, MPEG Layer 2 or PCM Audio Elementary Streams (Audio ES) as the output file 
formats. DVD authoring software accepts Video ES and Audio ES output files for creating 
DVD video titles. The following options table describes the format selections. 
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OUTPUT FORMAT SELECTION OPTIONS 

OPTION DESCRIPTION 
VOB (Video + Audio) Choose to encode a VOB (DVD Video Object) file. 
Video ES + Audio ES Encodes an MPEG-2 Video Elementary Stream and Dolby® Digital*, 

MPEG Layer 2, or PCM audio Elementary Stream. 
Video ES Encodes an MPEG-2 Video Elementary Stream only. 
Audio ES Encodes a Dolby® Digital*, MPEG Layer 2, or PCM audio Elementary 

Stream only. 
PS (Video + Audio) Choose to encode a PS (Program Stream) file. 
TS (Video + Audio) Choose to encode a TS (Transport Stream) file. 

* Applicable to ZP-330 encoder models only. 

The name of the Output Format drop-down list changes depending on the output format 
selected. Examples are shown below: 

OUTPUT FORMAT — VOB 

 

OUTPUT FORMAT — ES 

 

OUTPUT FORMAT — PS 
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OUTPUT FORMAT — TS 

 

 

In TS Mode, the file information for an encoded stream can be saved by 
specifying the title of the information file. The default setting for saving the 
information file is set to OFF in properties menu. 

2.a From the Output Format drop-down list, select Output file format(s). 

2.b Name the output files: 

OUTPUT FILE 

 
Use the Video File/VOB/PS/TS and Audio File drop-down lists for naming the output files 
and provide a path location on your hard drive. The availability of the Audio File drop-
down list is dependent on what item is selected in the Output Format drop-down list; for 
example, if VOB is selected, the Audio File drop-down list is not available because VOBs 
include both video and audio data. 

The output filename includes the destination path. 

For example: D:\workfolder\filename 
(has the destination path D:\workfolder) 

Video output files can have a specific filename extension automatically added by 
configuring the Properties dialog box. The Properties dialog box can be opened from the 
Options menu. 
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OUPUT FILES SELECTION OPTIONS 
OPTION DESCRIPTION 
Video File/VOB/PS/TS* Type in a path and name for your video/VOB/PS/TS output file or 

Browse. 
Audio File/Title Type in a path and name for your audio output file or Browse. 

For Title, type in a name for Encoding Information file. 

* When the output format is TS, multiple audio streams are selectable (Dolby® Digital and MPEG 
audio). If Single Audio is selected, the encoding process will be in Real-Time Encoding. If 
Multiple Audio is selected, the encoding process will be in Real–Time and Offline Encoding. 

BROWSE BUTTONS 
Located next to the Video File and Audio File drop-down lists are the Browse buttons. 
Use these buttons for selecting a destination path and/or existing output filename. If an 
existing output file is selected, it is overwritten. 

3. Configuring the Start and Stop Methods: 

 

When using the VTR remote control feature, the VTR Control check box must 
be selected in the Properties dialog box. For more information, see Chapter 2, 
“Configuring the ZP-Controller Properties Dialog Box.” 

 

 

 

The Start and Stop parameters determine if the encoding process is manually or 
automatically started and stopped. The start and stop parameters are not available for the 
NN encoder models. 

Frame accurate time-code based encoding can only be performed if the VTR supports 
Time-Code out, and is connected to the LTCIN connector of the Zapex Media Cable. 

Remote VTR control can only be performed if the VTR supports RS-422 remote control, and 
the VTR control cable is connected and configured correctly. For additional information, see: 

� Chapter 2, section 2.5, “Connecting the Media Cable and VTR Control Cable.” 

� Chapter 2, section 2.7, “Configuring the Drastic RS-422 VCR Control.” 

� Chapter 2, section 2.8, “Configuring the ZP-Controller Properties Dialog Box.” 
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START 

 
Use the Start control for determining if the encoding process begins automatically or 
manually. The following options table describes the items that can be selected. 

 

When typing in time-code, use the HH:MM:SS:FF format (HH is hours, MM is 
minutes, SS is seconds, and FF is a frame number). 

 

3.a From the Start drop-down list, select a start method. 

START SELECTION OPTIONS 
OPTION DESCRIPTION 
Time-Code This method automatically starts the encoding process at a specific time 

supplied by the VTR in LTC format. The start time must be typed into the 
text box. 
Choose to automatically start encoding at a specific time-code supplied 
by the VTR. 

Manual This method requires the encoding process to be started manually. A 
start button, located in the Real-Time Encoding window, is used for 
starting the process. 
Choose to manual start the encoding process from the Real-Time 
Encoding window. 
 

 

STOP 

 
Use the Stop control for determining whether the encoding process is stopped manually or 
automatically (time-code or duration methods). The following options table describes the 
items that can be selected. 

 

When typing in time-code, use the HH:MM:SS:FF format (HH is hours, MM is 
minutes, SS is seconds, and FF is a frame number). 
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3.b From the Stop drop-down list, select a stop method.option. 

STOP SELECTION OPTIONS 
OPTION DESCRIPTION 
Time-Code This method automatically stops the encoding process at a specified 

time. The time-code is supplied by the VTR in LTC format. Type the stop 
time into the text box. 
Choose to automatically stop encoding at a specific time supplied by the 
VTR. 

Manual This method requires the encoding process to be stopped manually. A 
stop button, located in the Real-Time Encoding window, is used for 
stopping the process. 
Choose to manually stop the encoding process from the Real-Time 
Encoding window. 

Duration This method automatically stops the encoding process after a specified 
period of time has passed. It performs like a timer.  
Choose to automatically stop the encoding process after a specified 
period of time has passed. Type the duration (length of time) into the text 
box using the HH:MM:SS format. 

 

 

The encode process length is based upon the information supplied for the Start 
and Stop Time-Codes, by either the VTR or typed into the text box.  The Zapex 
encoder will encode from the Start to the Stop Time-Code, less one frame. 

 
Start Time-Code      Stop Time-Code 

01:30:00:00      01:35:00:00 
Frame 1 Frame 2 Frame 3  Frame 8,999 Frame 9,000 Frame 9,001 

Start Encode → →  → Stop Encode  
↑     ↑ 

 

SET BUTTON 
The Set Time-Code dialog box appears when the Set button is clicked. It provides an 
alternative, and sometimes faster, method for entering and selecting time-code (see Figure 
3-2). The following options table describes the controls in this dialog box. 
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Figure 3-2. Set Time-Code Dialog Box 

 

SET TIME-CODE OPTIONS 
OPTION DESCRIPTION 
Time-Code Displays the time-code currently selected. 
Get Current T-C If a VTR is connected to the encoder and the VTR Control check box is 

selected in the Properties dialog box (from the Options menu), use this 
button to enter the current time-code (supplied by the VTR) into the Time-
Code text box. 

History Lists previously used time-codes. Double-click a time from this list to 
enter it into the Time-Code text box. 

OK Click to accept the time displayed in the Time-Code text box. 

4. Configuring the Video Encoding Parameters: 

Video parameters determine the techniques used for encoding the video stream. 

 

PREFERENCE 

 
Configuring the video parameters for an encoding session can be complex because of the 
many advanced MPEG-2 parameters to be considered. Zapex consolidated many of these 
parameters into a single command called Preference, then optimized it for the most 
common types of video content. The five video encoding preferences available are 
described in the following options table. 

4.a From the Video Preference drop-down list, select an encoding preference: 
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VIDEO ENCODING PREFERENCE SELECTION OPTIONS 
OPTION DESCRIPTION 
Standard Transition Video Optimized for encoding source video containing an even balance of slow, 

moderate, and quick moving images. 
Slow Transition Video Optimized for encoding source video that predominately have slow 

moving images. 
Quick Transition Video Optimized for encoding source video that predominately have scenes of 

fast moving. 
Animation/CG Optimized for encoding source video containing cartoon or computer 

generated images. 
Adaptive (with SCD, Filter) If this mode is selected, the Zapex encoder dynamically changes the type 

of Transition Video per GOP by analyzing the characteristic of the 
source video image.  In this mode, the Scene Change Detection (SCD) 
and Adaptive Softness Filter are always activated. See Appendix A, 
section A.3, “Advanced [Video] Button” for more information. 

 
The source video image GOP (Group of Pictures) is characterized by two numbers ‘N’ and 
‘M’ plus three types of pictures: 

‘N’ The number of pictures in the GOP 

‘M’ The frequency of ‘P’ pictures within the GOP 
 

‘I’ Picture coded with full picture information 
‘P’ Picture coded with respect to the previous ‘I’ or ‘P’ pictures 

‘B’ Picture coded with respect to the previous ‘I’ or ‘P’ picture, and/or the 
immediately next ‘I’ or ‘P’ picture 

 
 
 Adaptive mode uses a combination of Standard, Slow, and Quick Transition 

modes.  When Adaptive mode is selected, the SCD (Scene Change Detection) 
and Adaptive Softness Filter are always activated.  When SCD is selected in 
combination with Standard, Quick, or Animated/CG options, ‘N’ can range from 
1 to 16.   When SCD is selected in combination with Slow Transition option, ‘N’ 
can range from 1 to 15. 

 
The Video Encoding Preference Selection Options correspond to the following ‘M’ and ‘N’ 
numbers: 

 NTSC PAL 
Standard Transition Video N = 16 M = 2 N = 14 M = 2 
Slow Transition Video N = 15 M = 3 N = 15 M = 3 
Quick Transition Video N = 15 M = 1 N = 15 M = 1 
Animation/CG N = 16 M = 2 N = 14 M = 2 
Adaptive (with SCD, Filter) N = 1 to 16 M = 1, 2, or 3 * N = 1 to 14 M = 1, 2, or 3 * 

* ‘M’ is adaptive and automatically adjusted according to the detected scene changes. 
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RESOLUTION 

 
Use this control for selecting an encoding compression technique based on resolution. 
Choosing a higher resolution keeps the original video image quality in the output file. 
Choosing a lower resolution slightly reduces the video image quality in the output file. The 
following table describes the resolutions that can be selected. 

4.b From the Video Resolution drop-down list, select an encoding resolution: 

VIDEO RESOLUTION SELECTION OPTIONS 
OPTION DESCRIPTION 
720x480 (NTSC)./. 
720x576 (PAL) 

Also known as Full D1 Resolution. At this resolution, the entire source 
video frame is scanned and encoded. The encoded video resolution is 
equal to the source video resolution. 
Choose for sampling and encoding the entire video frame. 

704x480 (NTSC)./. 
704x576 (PAL) 

Also known as Full D1 Resolution. At this resolution, the entire source 
video frame is scanned and crops 8 pixels on left side and 8 pixels on 
right side during encoding.  

352x480 (NTSC)./. 
352x576 (PAL) 

Also known as Half D1 Resolution. At this resolution, the entire source 
video frame is scanned, and approximately every other pixel in the 
horizontal (left to right) resolution is encoded. During playback, an 
algorithm is used by the decoder to expand the video data to the full 
horizontal resolution. 
This slightly reduces the video quality for the gain of reducing the video 
output file size. 

 
CBR AND VBR 

 
Use the CBR (Constant Bit-Rate) and VBR (Variable Bit-Rate) buttons to select an 
encoding compression technique based on bit-rate. The CBR and VBR compression 
techniques are described below. 
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CBR./.VBR SELECTION OPTIONS 
OPTION DESCRIPTION 
CBR This technique creates a video output file compressed at a constant bit-

rate. The rate is set in the Bit-Rate options box. CBR compression gives 
you better control over the quality and size of the output file. Higher bit-
rates increase the image quality, but also increase the output file size. 
Choose for compressing the video data at a constant bit-rate specified 
in the Bit-Rate controls 

VBR This technique creates a video output file compressed at a variable bit-
rate. The maximum rate is set in the Bit-Rate options box. During VBR 
compression, the encoder automatically lowers the compression rate for 
scenes that are of slow transition type, and raises it for scenes of quick 
transition type, but not higher than the maximum set bit-rate. Using VBR 
optimizes the video quality-to-output file size relationship. 
Choose for compressing the video data at a variable bit-rate with the 
maximum rate specified in the Bit-Rate controls. 

 

4.c Use the CBR (Constant Bit-Rate) and VBR (Variable Bit-Rate) buttons to select an 
encoding compression technique based on bit-rate. 

BIT-RATE 

 

The Bit-Rate parameter controls the compression limits for the CBR and VBR encoding 
techniques. The selected value can be constant for CBR output files or the maximum rate 
for VBR output files. Type a value into the Mbps text box or use the slider to set the 
compression limit. 

4.d From the Bit-Rate controls, select the constant or maximum bit-rate: 

ADVANCED [VIDEO] BUTTON 
Please section A.3, “Advanced [Video] Button” in Appendix A. 
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5. Configuring the Audio Encoding Parameters: 

Figure 3-3. Audio Encoding Parameters 
AUDIO FORMATS WITH PS, ES AND VOB AUDIO FORMATS WITH TS 

  

 
FORMAT 
Use the Format parameter to set the type of audio output file to create. The audio 
encoding format is based on the encoder model you have and the output format selected. 
The following options table describes the formats that can be selected. Table 3-1 shows 
the audio parameter selection limitations. 

AUDIO ENCODING FORMAT SELECTION OPTIONS 
OPTION DESCRIPTION 
PCM Choose for encoding an audio source into stereo PCM audio. 
MPEG Audio Choose for encoding an audio source into MPEG Audio. 
Dolby® Digital Choose for encoding an audio source into Dolby® Digital audio 

(applicable to ZP-330 encoder models only). 
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Table 3-1. Audio Parameter Selection Limitations 
OUTPUT FORMAT  

ES VOB PS TS 
Sampling Frequency 48/44.1/32 kHz 48 kHz 48 kHz 48/44.1/32 kHz 
NTSC Format  Dolby® Digital 

 MPEG Audio 
 PCM 

 Dolby® Digital 
 PCM 

 Dolby® Digital 
 MPEG Audio 

 Dolby® Digital 
 MPEG Audio 

PAL Format  Dolby® Digital 
 MPEG Audio 

 PCM 

 Dolby® Digital 
 MPEG Audio 

 PCM 

 Dolby® Digital 
 MPEG Audio 

 Dolby® Digital 
 MPEG Audio 

DOLBY® DIGITAL 
Bit-Rate 56k-640 kbps 64k-448 kbps 112k-384 kbps 128k-384 kbps 
Encoding Mode 1/0, 2/0 1/0, 2/0 2/0 2/0 

MPEG AUDIO 
Bit-Rate 56k-384 kbps 64k-384 kbps 112k-384 kbps 128k-384 kbps 
Encoding Mode 1/0, 1+1, 2/0 1/0, 2/0 1/0, 1+1, 2/0 1+1, 2/0 

 
5.a From the Audio Format option buttons group, select an audio encoding format. 

SAMPLING-RATE 
The Sampling-Rate drop-down list provides various sampling frequencies for Dolby® 
Digital or MPEG output audio stream. For digital audio input select the sampling frequency 
of source audio stream. 

SAMPLING-RATE SELECTION OPTIONS 
OPTION DESCRIPTION 
32 kHz Choose for encoding an audio source into 32 kHz Dolby® Digital* or 

MPEG Layer 2 audio. 
44.1 kHz Choose for encoding an audio source into 44.1 kHz Dolby® Digital* or 

MPEG Layer 2 audio. 
48 kHz Choose for encoding an audio source into 48 kHz Dolby® Digital*, MPEG 

Layer 2 or PCM audio. 
AUTO If Auto is selected, the encoder automatically detects the sampling 

frequency of the source digital audio stream. The Auto mode appears for 
the Zapex DD and CD encoder models only. 

* Applicable to ZP-330 encoder models only. 

5.b From the Sampling-Rate drop-down list, select the sampling frequency of the Dolby® 
Digital or MPEG output audio stream. For digital audio input select the sampling 
frequency of source audio stream. 



38 ZP-230 & ZP-330 User’s Guide  —  Encoding Solutions for Digital Professionals 

ADVANCED PARAMETERS 
Please see: 

� Appendix B, “Dolby® Digital Encoding Parameters” 

� Appendix C, “MPEG Audio Encoding Parameters” 

� Appendix D, “Advanced System Parameters” 

3.4 THE ENCODE PROCESS 
This section describes the encode process, after the encoding parameters and controls in 
the ZP-Controller main window have been configured. 

Encoding is controlled and monitored from the Real-Time Encoding window. Depending on 
how the Start/Stop options in the ZP-Controller window are configured, encoding can be 
controlled manually or by using time-code. Figure 3-4 shows the Real-Time Encoding 
window in detail. 

Figure 3-4. Real-Time Encoding Window 
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3.4.1 MANUAL ENCODING 
This procedure is used when Manual has been selected in the Start/Stop settings. 

 TO START AND STOP MANUAL ENCODING PROCESS 

1. From the ZP-Controller window, click the Encode button to open the Real-Time Encoding 
window. 

2. Queue the VTR to a position about 10 seconds before the place you want to begin 
encoding. This ensures that the encoder has enough time to analyze the video and audio 
sources before encoding. 

3. From the VTR, begin playing the video. 

4. From the Real-Time Encoding window, click START to start the encoder. 

5. When the desired amount of video has been encoded, click STOP. 

6. Click OK to return to ZP-Controller’s main window. 

Your encoded video and audio files are stored at the file locations specified in the Video File 
and Audio File drop-down lists in the ZP-Controller window. 

3.4.2 DURATION BASED ENCODING 
This procedure is used when Manual has been selected in the Start setting and Duration 
has been selected in the Stop setting. Duration encoding works like a timer, automatically 
stopping the encoding process after a specified period of time.  Duration encoding uses 
the HH:MM:SS (Hours:Minutes:Seconds) format. 

 STARTING AND STOPPING DURATION BASED ENCODING 

1. From the ZP-Controller window, click the Encode button to open the Real-Time Encoding 
window. 

2. Queue the VTR to a position about 10 seconds before the place you want to begin 
encoding. This ensures that the encoder has enough time to analyze the video and audio 
sources before encoding. 

3. From the VTR, begin playing the video. 

4. From the Real-Time Encoding window, click START to start the encoder. 

5. When the duration time has been reached the encoder will automatically stop. 

6. Click OK to return to ZP-Controller’s main window. 

Your encoded video and audio files are stored at the file locations specified in the Video File 
and Audio File drop-down lists in the ZP-Controller window. 
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3.4.3 TIME-CODE ENCODING WITH VTR CONTROL 
This procedure can only be performed when the Start/Stop settings are set to time-code 
and if: 

� Your encoder model is connected to the VTR using the VTR Control Cable 

� The VTR Control check box is selected in the Properties dialog box 

� The Time-Code cable is connected to the LTCIN connector of the Zapex Media 
Cable 

The Properties dialog box can be opened from the Options menu. 

 

The VTR Control checkbox must be selected in the Properties dialog box, and 
the VTR set to remote control. For more information, see Chapter 2, and your 
VTR User’s Guide. 

 

 TO AUTOMATICALLY START AND STOP THE ENCODING PROCESS WITH VTR 
CONTROL 

1. From the ZP-Controller window, click the Encode button to open the Real-Time Encoding 
window. 

2. The ZP-Controller automatically queues the VTR to 10 seconds before the beginning of the 
segment of video that must be encoded, then begins the encoding process. When the end of 
the segment has been reached, ZP-Controller automatically stops the encoding process and 
the VTR. 

3. Click OK to return to ZP-Controller’s main window. 

Your encoded video and audio files are stored at the file locations specified in the Video File 
and Audio File drop-down lists in the ZP-Controller window. 
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3.4.4 TIME-CODE ENCODING WITHOUT VTR CONTROL 
This procedure is for VTRs that do not support RS-422 remote control. The encoder 
model's LTCIN connection is made to the VTR's Time-Code out connector (see Chapter 2, 
section 2.4, "Connecting the Media Cable" for connection instructions), and the Start/Stop 
settings are set to time-code. 

 TO AUTOMATICALLY START AND STOP THE ENCODING PROCESS 

1. Manually rewind (Queue) the VTR to approximately 10 seconds prior to the beginning of the 
clip that is to be encoded. 

2. Press play on the VTR. 

3. From the ZP-Controller window, click the Encode button to open the Real-Time Encoding 
window. ZP-Controller automatically starts and stops the encoding process when the start 
and stop time codes are reached. 

4. Click OK to return to the ZP-Controller main window. 

Your encoded video and/or audio files are stored at the file locations specified in the Video 
File and Audio File drop-down lists in the ZP-Controller window. 
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3.5 ENCODING WINDOW FOR MULTI-AUDIO TS OUTPUT 
Two encoding processes are running in multi-audio TS Output Format. One process is the 
Real-Time encoding process and another is a TS MUX Process. In thr Real-Time encoding 
process, the Video stream and PCM Audio stream are captured and saved in a specified 
directory on the hard disk drive. 

Once the Real-Time encoding process is complete, the TS MUX Process window opens.  
(See Figure 3-5.) 

Figure 3-5. TS MUX Process Window 

 

 
The process to multiplex multiple audio for TS output requires three steps. 

1. Convert PCM audio to Dolby® Digital (Encoding Dolby Digital Audio) 
2. Convert PCM audio to MPEG audio (Encoding MPEG Audio) 
3. Multiplex Video Stream, Dolby® Digital Stream and MPEG Audio Stream 

(Multiplexing Video and Audio). 
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3.6 SAVING YOUR WORK AS A PROJECT FILE 
Encoding parameter values can be saved in a project file so that the encoding 
configuration can be recalled for another session. Project files have a ZAP filename 
extension 

 TO SAVE A PROJECT FILE 

1. Configure ZP-Controller as described in section 3.4, “Configuring ZP-Controller for a Simple 
Encoding Session.” 

2. Click File and select Save Project As. 

3. In the Save in drop-down list, select a destination (path) where the project file is to be saved. 

4. In the File name drop-down list, type in a name for your project file. 

5. Click Save to exit the Save as dialog box. 

3.7 DEFAULT ENCODING AND CONTROL VALUES 
All the encoding parameters and control values in the ZP-Controller window can be set to 
specific values you choose, so that every time you begin a new encoding session, you can 
start with values used most frequently. 

 TO SET INITIAL ENCODING VALUES TO YOUR OWN PREFERENCE 

1. From the ZP-Controller window, choose the encoding parameter and control values that you 
prefer to set as default values. 

2. From the File menu, select Set As User Default. 

 

The Advanced buttons that appear in the ZP-Controller main window open 
various windows to advanced encoding parameters. Some of these advanced 
windows have a default button. This default button sets those advanced 
parameters to factory default values. The default buttons do not set the values 
you chose. 
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3.8 OPENING AN EXISTING PROJECT FILE 
The encoding values stored in an existing project file can be reused in ZP-Controller for 
new encoding sessions. 

 TO OPEN A PROJECT FILE 

1. From the ZP-Controller window, click File, and select Open Project. The Open dialog box 
appears. 

2. Use the Look in drop-down list to navigate to the location of the project file. Project files 
have the ZAP filename extension. 

3. Select the project file then click Open. 

3.9 UPDATING AN EXISTING PROJECT FILE 
 TO UPDATE THE CHANGES MADE TO AN EXISTING PROJECT FILE 

1. Open the project file you want to use and make the required encoding parameter and control 
changes. 

2. From the File menu, select Save Project. 

3.10 QUITTING ZP-CONTROLLER 

 

You can quit ZP-Controller any time except during the encoding process. 

 TO QUIT ZP-CONTROLLER 

From the File menu, select Exit. 
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C H A P T E R  

44  
OFF-LINE ENCODING 
This chapter contains the following information: 

9 Starting ZP-Controller 
9 Encoding Session — Configuring the ZP-Controller 
9 The ZP Controller Main Window 
9 The Encode Process 
9 Saving Your Work as a Project File 
9 Default Encoding and Control Values 
9 Opening an Existing Project File 
9 Updating an Existing Project File 
9 Quitting ZP-Controller 
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4.0 OFF-LINE ENCODING 
Off-Line encoding is similar to Real-Time encoding. The main difference is that the source 
video is not supplied by a VTR. Off-Line source video is obtained from a file stored on a 
hard disk. Source file types that can be encoded are AVI and WAV. 

 

Off-Line encoding supports 24-bit color AVI files. If the AVI file is 
compressed, it must be uncompressed using a 24-bit codec. 

4.1 STARTING ZP-CONTROLLER 
 STARTING ZP-CONTROLLER 

Click the Windows Start button, point to Programs, then ZP-230 or ZP-330, select 
ZP-Controller. 

4.2 ENCODING SESSION — CONFIGURING THE 
ZP-CONTROLLER 

This section describes how to configure ZP-Controller for an encoding session. For 
detailed information about the encoding parameters discussed in this section, see the 
following topics. 

� Chapter 1, “System Overview and Requirements” 

� Appendix A, “Advanced Encoding Parameters” 

� Appendix B, “Dolby® Digital Encoding Parameters” 

� Appendix C, MPEG Audio Encoding Parameters” 

 
Depending on the model you have, some features may not be available. 
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4.3 THE ZP-CONTROLLER MAIN WINDOW 
When starting ZP-Controller, the main window appears. Figure 4-1 shows the major 
elements found on the main window. 

Figure 4-1. ZP-Controller Main Window 
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 CONFIGURING THE ZP-CONTROLLER FOR AN ENCODING SESSION 

1. Configuring the Frame Type and Input File. 

Input parameters tell the encoder information about the source video to be encoded. 

FRAME TYPE 

 
Use the Frame Type drop-down list for selecting AVI / WAV source files. 

1.a From the Frame Type drop-down list, select AVI / WAV File. 

1.b Click Browse to select the source file you want to encode. 

 
2. Configuring the Output Parameters: 

Output parameters determine the type of encoded output files that are produced. 

FORMAT 

 
Use the Format drop-down list for choosing VOB, MPEG-2 video elementary streams, PS, 
and/or Dolby® Digital, MPEG Layer 2, or PCM audio elementary streams as the output 
files. DVD authoring software accepts Video ES and Audio ES output files for creating 
DVD video titles. 

2.a From the Output Format drop-down list, select the output file format(s): 
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OUTPUT FORMAT SELECTION OPTIONS 
OPTION DESCRIPTION 
VOB (Video + Audio) Choose to encode a VOB (DVD Video Object) file. 
Video ES + Audio ES Encodes an MPEG-2 Video Elementary Stream and a Dolby® Digital*, MPEG 

Layer 2, or PCM audio Elementary Stream. 
Video ES Encodes an MPEG-2 Video Elementary Stream only. 
Audio ES Encodes a Dolby® Digital, MPEG Layer 2, or PCM audio Elementary Stream 

only. 
PS (Video + Audio) Choose to encode a PS (Program Stream) file. 

* Applicable to ZP-330 encoder models only. 

 

To select VOB (Video + Audio), PS (Video + Audio), or Video ES + Audio ES, 
the source file must be a single AVI file containing both video and audio. 

 

VIDEO FILE AND AUDIO FILE 

 

Use the Video File and Audio File drop-down lists for naming the output files and 
providing them a path location on your hard drive. The availability of the Audio File drop-
down list is dependent on what format is selected in the Format drop-down list. For 
example: if VOB is selected, the Audio File drop-down list is not available because VOBs 
include video and audio data. 

The output filename includes the destination path. 

For example: D:\workfolder\filename 
(has the destination path D:\workfolder) 

Video output files have specific filename extensions automatically added by configuring the 
Properties dialog box. The Properties dialog box can be opened from the Options menu. 

BROWSE BUTTONS 
Located next to the Video File and Audio File drop-down lists are the Browse buttons. 
Use these buttons for selecting an existing output file. If an existing output file is selected, 
it is overwritten. 
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2.b Name the output files: 

OUPUT FILES SELECTION OPTIONS 
OPTION DESCRIPTION 
Video File./.VOB./.PS Type in a path and name for your video/VOB/PS/TS output file or 

Browse. 
Audio File./.Title Type in a path and name for your audio output file or Browse. 

For Title, type in a name for Encoding Information file. 

 

3. Configuring the Video Encoding Parameters: 

Video parameters determine the method used for encoding the video stream. 

 

PREFERENCE 

 
Configuring the video parameters for an encoding session can be complex because of the 
many advanced MPEG-2 parameters that must be considered. Zapex has consolidated 
many of these parameters into a single command called Preference, then optimized it for 
the most common types of video content. The video encoding preferences available are 
described in the options table below. 

3.a From the Video Preference drop-down list, select an encoding preference: 
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VIDEO ENCODING PREFERENCE SELECTION OPTIONS 
OPTION DESCRIPTION 
Standard Transition Video Optimized for encoding source videos containing an even balance of slow, 

moderate, and quick moving images. 
Choose for source video having an even balance of slow, moderate, and quick 
moving images. 

Slow Transition Video Optimized for encoding source videos that predominately have slow moving 
images. 
Choose for source video that predominately have slow moving images. 

Quick Transition Video Optimized for encoding source videos that predominately have scenes of fast 
moving images. 
Choose for source video that predominately have fast moving images. 

Animation/CG Optimized for encoding source video containing cartoon or computer generated 
images. 
Choose for source video containing cartoon or computer generated images. 

Adaptive (with SCD, Soft. Filter) If this mode is selected, the Zapex encoder dynamically changes the type of 
Transition Video per GOP by analyzing the characteristic of the source video 
image.  In this mode, the Scene Change Detection (SCD) and Adaptive 
Softness Filter are always activated. 

 
The source video image GOP (Group of Pictures) is characterized by two numbers ‘N’ and 
‘M’ plus three types of pictures: 

‘N’ The number of pictures in the GOP 

‘M’ The frequency of ‘P’ pictures within the GOP 
 
‘I’ Picture coded with full picture information 

‘P’ Picture coded with respect to the previous ‘I’ or ‘P’ pictures 

‘B’ Picture coded with respect to the previous ‘I’ or ‘P’ picture, and/or the 
immediately next ‘I’ or ‘P’ picture 

 
 
 

Adaptive mode uses a combination of Standard, Slow, and Quick Transition 
modes.  When Adaptive mode is selected, the SCD (Scene Change Detection) 
and Adaptive Softness Filter are always activated.  When SCD is selected in 
combination with Standard, Quick, or Animated/CG options, ‘N’ can range from 
1 to 16.   When SCD is selected in combination with Slow Transition option, ‘N’ 
can range from 1 to 15. 

 

The Video Encoding Preference Selection Options correspond to the following ‘M’ and ‘N’ 
numbers: 

 NTSC PAL 
Standard Transition Video N = 16 M = 2 N = 14 M = 2 
Slow Transition Video N = 15 M = 3 N = 15 M = 3 
Quick Transition Video N = 15 M = 1 N = 15 M = 1 
Animation/CG N = 16 M = 2 N = 14 M = 2 
Adaptive (with SCD, Filter) N = 1 to 16 M = 1, 2, or 3 * N = 1 to 14 M = 1, 2, or 3 * 

* ‘M’ is adaptive and automatically adjusted according to the detected scene changes. 
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RESOLUTION 
The encode resolution cannot be adjusted in the Off-Line encoding mode. The source AVI 
file is transcoded into MPEG at the source file’s resolution. The table below identifies the 
resolutions supported. 

SUPPORTED RESOLUTIONS (VOB OR PS)  SUPPORTED RESOLUTIONS (ES) 
NTSC 
RESOLUTIONS 

PAL 
RESOLUTIONS 

 NTSC 
RESOLUTIONS 

PAL 
RESOLUTIONS 

720 x 486   720 x 486  
720 x 480 720 x 576  720 x 480 720 x 576 
352 x 480 352 x 576  640 x 480 640 x 576 
352 x 240 352 x 288  352 x 480 352 x 576 

   320 x 480 320 x 576 
   352 x 240 352 x 288 
   320 x 240 320 x 288 

 

 

Source files with the NTSC resolution of 720 x 486 will have the top 2 lines 
and the bottom 4 lines cropped. 

 

START/STOP PARAMETERS 
 

 

The Start and Stop controls are not available for Off-Line encoding. 

 

3.b Use the CBR (Constant Bit-Rate) and VBR (Variable Bit-Rate) buttons to select an 
encoding compression technique based on bit-rate. 

CBR AND VBR 
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CBR/VBR SELECTION OPTIONS 
OPTION DESCRIPTION 
CBR This technique creates a video output file compressed at a constant bit-rate. The 

rate is set in the Bit-Rate options box. CBR compression gives you better control 
over the quality and size of the output file. Higher bit-rates increase the image 
quality, but also increase the output file size. 
Choose for compressing the video data at a constant bit-rate specified in the 
Bit-Rate controls. CBR provides greater video quality control, but increases the 
video output file size. 

VBR This technique creates a video output file compressed at a variable bit-rate. The 
maximum rate is set in the Bit-Rate options box. During VBR compression, the 
encoder automatically lowers the compression rate for scenes that are of slow 
transition type, and raises it for scenes of quick transition type, but not higher than 
the maximum set bit-rate. Using VBR optimizes the video quality-to-output file size 
relationship. 
Choose for compressing the video data at a variable bit-rate with the maximum 
rate specified in the Bit-Rate controls. VBR provides lower video quality control, but 
decreases the video output file size. 

 

BIT-RATE 
The Bit-Rate parameter controls the compression limits for the CBR or VBR encoding 
techniques. The selected value is constant for CBR output files or the maximum rate for 
VBR output files. Type a value into the Mbps text box or use the slider to set the 
compression limit. 

 

Type a rate into the Mbps text box, or use the slider to select a rate. 

3.c From the Bit-Rate controls, select the constant or maximum bit-rate. 

ADVANCED [VIDEO] BUTTON 
See Appendix A, section A.3, “Advanced [Video] Button” for detailed information. 
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4. Configuring the Audio Encoding Parameter: 

FORMAT 
From the Audio Format option buttons group box, select an audio encoding format. 
The audio formats that are available depend on the encoder model you have. The 
format types are described in the following option selection table. 

 
 

AUDIO ENCODING FORMAT SELECTION OPTIONS 
OPTION DESCRIPTION 
PCM Choose for encoding AVI or WAVE data into stereo PCM audio. 
MPEG Audio Choose for encoding AVI or WAVE data into MPEG Layer 2. 
Dolby Digital Choose for encoding AVI or WAVE data into Dolby® Digital audio*.  

* Applicable to ZP-330 encoder models only. 

SAMPLING-RATE 
From the Sampling-Rate drop-down list, select the sampling frequency of the Dolby® 
Digital or MPEG output audio stream. For digital audio input select the sampling frequency 
of source audio stream. The sampling-rate of audio data in AVI and WAV files are 
converted to 48 kHz if you specify a sampling rate of 48 kHz in the Sampling-Rate drop-
down list. Audio sampling rates of 22.05 kHz, 32 kHz, and 44.1 kHz are supported for 
sampling-rate conversion. 
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SAMPLING-RATE SELECTION OPTIONS 
OPTION DESCRIPTION 
32 kHz Choose for encoding a 32 kHz AVI or WAVE data into 32 kHz Dolby® Digital* or 

MPEG Layer 2 audio. 
44.1 kHz Choose for encoding a 44.1 kHz AVI or WAVE data into 44.1 kHz Dolby® Digital* 

or MPEG Layer 2 audio. 
48 kHz Choose for encoding a 48 kHz AVI or WAVE data into 48 kHz Dolby® Digital* or 

MPEG Layer 2 audio. 
AUTO If Auto is selected, the Zapex encoder automatically detects the sampling 

frequency of the source audio stream, and encodes a Dolby® Digital*, or MPEG 
Layer2 audio stream. 

* Applicable to ZP-330 encoder models only. 

 

The sampling-rate of audio data in AVI and WAV files are converted to 48 kHz 
if you specify a sampling rate of 48 kHz in the Sampling-Rate drop-down list. 
Audio sampling rates of 22.05 kHz, 32 kHz, and 44.1 kHz are supported for 
sampling-rate conversion. 

ADVANCED [AUDIO] BUTTON 
Please see: 

� Appendix B, “Dolby® Digital Encoding Parameters” 

� Appendix C, “MPEG Audio Encoding Parameters” 

4.4 THE ENCODE PROCESS 
Click Encode to begin encoding. 

When the encoding process begins the Off-Line Encoding window appears. This window 
allows you to monitor or stop the encoding process. Your encoded video and audio files 
can be found at the path shown by the Video File and Audio File drop-down lists in the 
ZP-Controller window. 
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4.5 SAVING YOUR WORK AS A PROJECT FILE 
The value of each encoding parameter can be saved in a project file so that the encoding 
configuration can be used for other sessions. Project files have the ZAP filename 
extension 

 TO SAVE A PROJECT FILE 

1. Configure ZP-Controller as described in Chapter 2, “Configuring the ZP-Controller Properties 
Dialog Box.” 

2. Click File and select Save Project as to open the Save As dialog box. 

3. In the Save in drop-down list, select a destination (path) where the project file must be 
saved. 

4. In the File name drop-down list, type in a name for your project file. 

5. Click Save to exit the Save As dialog box. 

4.6 DEFAULT ENCODING AND CONTROL VALUES 
All the encoding parameters and control values in ZP-Controller can be set to specific 
values you choose, so each time you begin a new configuration, you can start with the 
values most frequently used. 

 TO SET INITIAL ENCODING VALUES TO YOUR OWN PREFERENCE 

1. From the ZP-Controller window, choose the encoding parameters and control values that you 
prefer to set as default values. 

2. From the File menu, select Set As User Default. 

 

Located in the ZP-Controller main window are Advanced buttons that open 
windows to advanced encoding parameters. Some of these advanced 
windows have a default button. The default button sets the advanced 
parameters to a factory default value. The default buttons do not set the 
values you chose. 
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4.7 OPENING AN EXISTING PROJECT FILE 
The encoding values stored in an existing project file can be opened in ZP-Controller and 
used for a new encoding session. 

 TO OPEN A PROJECT FILE 

1. Click File and select Open Project. The Open dialog box appears. 

2. Use the Look in drop-down list to navigate to the location of the project file. Project files 
have the ZAP filename extension. 

3. Select the project file then click Open. 

4.8 UPDATING AN EXISTING PROJECT FILE 
 TO UPDATE THE CHANGES MADE TO AN EXISTING PROJECT FILE 

1. Open the project file you want to use and make the required encoding parameter and control 
changes. 

2. From the File menu, select Save Project. 

4.9 QUITTING ZP-CONTROLLER 

 

You can quit ZP-Controller any time except during the encoding process. 

 

 TO QUIT ZP-CONTROLLER 

From the File menu, select Exit. 
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OFF-LINE ENCODING USING ADOBE® PREMIERE® 
This chapter contains the following information: 

9 An Off-Line Encoding Session 
9 Selecting a Video Project 
9 Export Movie Settings 

� Export Movie Settings Dialog Box - General Settings 
� Export Movie Settings Dialog Box - Audio Settings 
� Export Movie Settings Dialog Box – Special Processing 
� How to Crop a Video in Adobe® Premiere® 

9 Configuring Zapex Encoder Parameters 
� Configuring the Zapex Encoder Parameters Audio Tab 
� Configuring Zapex Encoder Parameters System Tab 

9 Apply the Configurations and Begin Encoding 
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5.0 OFF-LINE ENCODING USING ADOBE® PREMIERE® 
This section describes how to configure the Zapex Plug-in of Adobe® Premiere® for an 
encoding session. No advanced configurations are described. For detailed information 
about the basic and advanced encoding parameters, see the following topics. 

� Appendix A, “Advanced Encoding Parameters” 

� Appendix B, “Dolby® Digital Encoding Parameters” 

� Appendix C, “MPEG Audio Encoding Parameters” 

Video and audio source files that have been edited in Adobe® Premiere® can be encoded 
into a PS/VOB or MPEG-2 Video Elementary Stream, and/or a Dolby® Digital, MPEG 
Layer 2, or PCM audio elementary stream. 

 
Depending on the model you have, some features may not be available. 

5.1 AN OFF-LINE ENCODING SESSION 
The following instructions provide the information needed to do a step-by-step off-line 
encoding session. 

� Selecting a Video Project 

� Export Movie Settings Dialog Box – General Settings 

� Export Movie Settings Dialog Box – Video Settings 

� Export Movie Settings Dialog Box – Audio Settings 

� Configuring Zapex Encoder Parameters Window – Video Tab 

� Configuring Zapex Parameters Window – Audio Tab 

� Configuring Zapex Parameters Window – System Tab 

� Applying the Configuration and Beginning Encoding 
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5.2 SELECTING A VIDEO PROJECT 
1. From Adobe® Premiere®, open the video project you want to encode. 

2. From the File menu, click Export and select Movie to open the Export Movie dialog box. 
Refer to Figure 5-1. 

Figure 5-1. Export Movie Dialog Box 

 

Type a name for the 
output file here. 

Output files from previous 
encoding sessions are 
displayed here. 

Select a destination for the 
output files from here. 

SAVE IN 
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From the Export Movie dialog box, use the Save in drop-down list to select a destination 
(path) for your output files. The destination can be any directory on any local hard drive 
that has space for the files. 

3. From the Save in  drop-down list select the destination for the output file by selecting a drive 
and directory. 

FILE NAME 

 
From the Export Movie dialog box, use the File name text box for typing in a name for the 
output file. If video and audio output files are to be encoded as separate files, the name is 
incorporated into both output files. Depending on selections made in the Export Movie 
Settings — Audio Settings dialog box, the output filename extension is added 
automatically: VOB for DVD Video Object files; MPG, MP2, M2V, or VBS for video output 
files; MP2 for PS (program stream), and AC3, MPA or WAV for audio output files. 

4. In the File name text box, type the name of the output file. 

5.3 EXPORT MOVIE SETTINGS 
The Export Movie Settings dialog box is opened by clicking Settings from the Export 
Movie dialog box. Four types of source file and encoding settings can be configured: 

� General Settings 

� Video Settings 

� Audio Settings 

� Special Processing 

5. Click Settings to open the Export Movie Settings dialog box. Figure 5-2 shows a detail of 
the Export Movie Settings dialog box as it first appears. General Settings is the first set of 
parameters that are available. 
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Figure 5-2. Export Movie Settings Dialog Box – General Settings 

 

 
GENERAL SETTINGS 
General Settings provides controls for configuring the type of video output file that is 
created (encoded). The Zapex Encoder Parameters window can also be opened here. 
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5.3.1 EXPORT MOVIE SETTINGS DIALOG BOX - GENERAL SETTINGS 
In the Export Movie Settings dialog box — General Settings view there is a File Type 
drop-down list. See Figure 5-3. 

Figure 5-3. General Settings —File Type Drop-down List 

 

FILE TYPE 

 

Select the type of output file to 
encode from here. 

Use the File Type drop-down list to select the type video and audio output file to 
encode. DVD authoring software accepts ES (Elementary Stream) output files. The 
following table describes the File Type options available. 

FILE TYPE SELECTION OPTIONS 
Option DESCRIPTION 
ZAPEX PS Encodes an MPGE-2 Program Stream (multiplexed video and audio). 
ZAPEX ES Encodes an MPEG-2 Video Elementary Stream, and a Dolby® Digital, or 

MPEG Layer 2, or PCM audio Elementary Stream. 
ZAPEX VOB Encodes a DVD Video Object file that can be viewed by a DVD decoder. 

 
1. From the File Type drop-down list, select the encoding format. Refer to the following File 

Type selections table: 

VIDEO AND AUDIO EXPORT 
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Use the video and Audio export check box options to export video only, audio only, or 
video and audio. Export options are determined by the selected file type (VOB or ES). 
For example: a file type of VOB requires that both Export Video and Export Audio 
are selected. 

RANGE 

 
Use the Range drop-down list to select the encoding range. 

RANGE SELECTION OPTIONS 
Option DESCRIPTION 
Entire Project Encodes all the source material on the project time-line. 
Work Area Encodes the source material that is in the work area. 

 
2. In the Range drop-down list, select the desired range to be encoded. Select Entire project or 

work area. 

3. Depending on the format of the video stream(s) you want to export, select the Export Video 
and/or Export Audio check box(s). 

 

Always keep the Open When Finished check box clear. 

4. Clear the Open When Finished check box. 

 
 

Since the Zapex plug-in for Adobe® Premiere® only supports encoding, if this 
parameter is checked, the following error message will appear at the end of 
exporting process: 

“Unable to open that file. File is an unsupported type.” 

ADVANCED SETTINGS BUTTON 
This button to opens the Zapex Encoder Parameters window. See “Zapex Encoder 
Parameters Window” later in this chapter. 

Click Advanced Settings button to open the Zapex Encoder Parameters window. 
Refer to Figure 5-6. 
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5.3.2 EXPORT MOVIE SETTINGS DIALOG BOX - VIDEO SETTINGS 
1. From the Export Movie Settings drop-down list (General Settings is currently selected), 

select Video Settings. Figure 5-4 shows a detail of the Export Movie Settings – Video 
Settings dialog box. 

Figure 5-4. Export Movie Settings – Video Settings 

 

VIDEO SETTINGS 
The Video Settings provides the controls for configuring resolution and frame rate of the 
source and output video files. 

FRAME SIZE 

 

2. Use the horizontal and vertical Frame Size text boxes for configuring the resolution of the 
video output. The table below identifies the resolutions that are supported. 

SUPPORTED RESOLUTIONS (VOB OR PS)  SUPPORTED RESOLUTIONS (ES) 
NTSC 
RESOLUTIONS 

PAL 
RESOLUTIONS 

 NTSC 
RESOLUTIONS 

PAL 
RESOLUTIONS 

720 x 480 720 x 576  720 x 480 720 x 576 
352 x 480 352 x 576  640 x 480 640 x 576 
352 x 240 352 x 288  352 x 480 352 x 576 

   320 x 480 320 x 576 
   352 x 240 352 x 288 
   320 x 240 320 x 288 
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If the source video is smaller than the selected resolution, the final image is 
stretched. 
If the source video resolution is greater than the resolutions shown in the 
above tables, the image can be scaled down or cropped. For more 
information, see “Special Processing.” 

 

FRAME RATE 

 
3. Set the Frame Rate drop-down list to 29.97 for NTSC and 25 for PAL. 

5.3.3 EXPORT MOVIE SETTINGS DIALOG BOX - AUDIO SETTINGS 
AUDIO SETTINGS 
The Audio Settings provide controls for configuring the basic parameters for the source 
audio and output audio files. 

1. From the Export Movie Settings drop-down list (Video Settings is currently selected), 
select Audio Settings. Refer to Figure 5-5. 

Figure 5-5. Export Movie Settings – Audio Settings 

 

RATE 
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Use the Rate drop-down list for setting the sampling rate of the audio output. 48 kHz 
sampling rate is available for both PCM, MPEG-1 Layer 2 and Dolby® Digital audio 
(DVD compatible). The 32 kHz and 44.1 kHz sampling rates are available for Dolby® 
Digital, MPEG Layer 2 audio. 

 

When either Zapex PS or Zapex VOB has been selected in File Type under 
General Settings, 48000 Hz is the only sampling rate available. 

2. From the Rate drop-down list, select the sample rate of the audio output. 

 

When either Zapex PS or Zapex VOB has been selected in File Type under 
General Settings, 48000 Hz is the only sampling rate available. 

 

FORMAT 

 
Use the Format drop-down list for setting the bit resolution and number of channels of 
the source audio. Always choose a setting that matches the source audio. 

3. From the Format drop-down list, select the bit resolution and number of channels of the 
audio output. 

TYPE 

 
Use the Type drop-down list for setting the type of audio output file you want to 
create. 

AUDIO SETTINGS – TYPE SELECTION OPTIONS 
Option DESCRIPTION 
PCM Choose for encoding the source audio into stereo PCM audio. 
Dolby Digital Choose for encoding the source audio into Dolby® Digital* audio.  
MPEG Audio Choose for encoding the source audio into MPEG audio. 

* Applicable to ZP-330 encoder models only. 

 
4. From the Type drop-down list, select an audio encoding type. The audio encoding types 

available are dependent on the encoder model you have. 

5. From the Export Movie Settings drop-down list (Audio Settings is currently selected), 
select General Settings. 
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5.3.4 EXPORT MOVIE SETTINGS DIALOG BOX – SPECIAL PROCESSING 
Special Processing is used to crop source video that has a resolution greater than 720x480 
for NTSC and 720x576 for PAL. This means that Premiere® does not have to scale the 
source to 720x480 for NTSC or 720x576 for PAL prior to encoding. 

 

5.3.5 HOW TO CROP A VIDEO IN ADOBE® PREMIERE® 
1. In the Export Settings Video Frame Size text boxes, type the resolution of the source 

video. 

2. From the Export Settings drop-down list, select Special Processing. 

3. Click the Modify button. 

4. In the Top and Bottom text boxes, type in the number of lines you want cropped from the 
top and bottom of the video frame. Use only even numbers, for example, 2, 4, and 6. 

5. Click OK. 
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5.4 CONFIGURING ZAPEX ENCODER PARAMETERS 
There are three tabs available through the Zapex Encoder Parameters window: the Video 
Tab, the Audio Tab, and the System Tab.  All three are discussed in this section. 

Figure 5-6. Zapex Encoder Parameters Window – Video Tab 

Output file Resolution Min-Max bit-rate table.

Click here to accept the encoding configuration.

Click these tabs to select video or audio encoding controls. 

Click here to
see more

information
about the

Parameters
window.
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5.4.1 CONFIGURING THE ZAPEX ENCODER PARAMETERS VIDEO TAB 
VIDEO [TAB] 
Parameters in the Video tab are used for specifying the video output you want to encode. 

PREFERENCE 

 
Configuring the video parameters for an encoding session can be a complex job 
because of the many advanced MPEG-2 parameters that must be considered. Zapex 
has consolidated many of these parameters into a single command called Preference, 
then optimized it for the most common types of video content. The four video 
encoding Preferences available are described in the following options table. 

ENCODING PREFERENCE SELECTION OPTIONS 
Option DESCRIPTION 
Standard Transition Video Optimized for encoding source videos containing an even balance of 

slow, moderate, and quick moving images. 
Slow Transition Video Optimized for encoding source videos that predominately have slow 

moving images. 
Quick Transition Video Optimized for encoding source videos that predominately have scenes of 

fast moving images. 
Animation/CG Optimized for encoding source videos containing cartoon or computer 

generated images. 
Adaptive (with SCD and Soft. 
Filter) 

If this mode is selected, the Zapex encoder dynamically changes the type 
of Transition Video per GOP by analyzing the characteristic of source 
video image. In this mode, the Scene Change Detection (SCD) and 
Adaptive Softness Filter are always activated. 

 

The source video image GOP (Group of Pictures) is characterized by two numbers ‘N’ and 
‘M’ plus three types of pictures: 

‘N’ The number of pictures in the GOP 

‘M’ The frequency of ‘P’ pictures within the GOP 
 
‘I’ Picture coded with full picture information 
‘P’ Picture coded with respect to the previous ‘I’ or ‘P’ pictures 

‘B’ Picture coded with respect to the previous ‘I’ or ‘P’ picture, and/or the 
immediately next ‘I’ or ‘P’ picture 
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 Adaptive mode uses a combination of Standard, Slow, and Quick Transition 

modes.  When Adaptive mode is selected, the SCD (Scene Change Detection) 
and Adaptive Softness Filter are always activated.  When SCD is selected in 
combination with Standard, Quick, or Animated/CG options, ‘N’ can range from 
1 to 16.   When SCD is selected in combination with Slow Transition option, ‘N’ 
can range from 1 to 15. 

 
The Video Encoding Preference Selection Options correspond to the following ‘M’ and ‘N’ 
numbers: 

 NTSC PAL 
Standard Transition Video N = 16 M = 2 N = 14 M = 2 
Slow Transition Video N = 15 M = 3 N = 15 M = 3 
Quick Transition Video N = 15 M = 1 N = 15 M = 1 
Animation/CG N = 16 M = 2 N = 14 M = 2 
Adaptive (with SCD, Filter) N = 1 to 16 M = 1, 2, or 3 * N = 1 to 14 M = 1, 2, or 3 * 

* ‘M’ is adaptive and automatically adjusted according to the detected scene changes. 

1. From the Preference drop-down list, select an encoding preference. 

CBR AND VBR 

 
Use the CBR (Constant Bit-Rate) and VBR (Variable Bit-Rate) buttons to select an 
encoding compression technique based on bit-rate. 

CBR/VBR SELECTION OPTIONS 
OPTION DESCRIPTION 
CBR This technique creates a video output file compressed at a constant bit-

rate. The rate is set in the Bit-Rate options box. CBR compression gives 
you better control over the quality and size of the output file. Higher bit-
rates increase the image quality, but also increase the output file size. 

VBR This technique creates a video output file compressed at a variable bit-
rate. The maximum rate is set in the Bit-Rate options box. During VBR 
compression, the encoder automatically lowers the compression rate for 
scenes that are of slow transition type, and raises it for scenes of quick 
transition type, but not higher than the maximum set bit-rate. Using VBR 
optimizes the video quality-to-output file size relationship. 

 

2. Use the CBR or VBR button to select an encoding technique. Refer to the selection options 
table. 
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BIT-RATE 

 
The Bit-Rate parameter controls the compression limits for the CBR and VBR 
encoding techniques. The selected value can be constant for CBR output files or the 
maximum rate for VBR output files. Type a value into the Mbps text box or use the 
slider to set the compression limit. 

3. From the Bit-Rate controls, select a constant or maximum bit-rate. Type a bit-rate into the 
Mbps text box, or use the slider to select a bit-rate using the output resolution min-max 
bit-rate table. 

ADVANCED BUTTON 
Use this button for accessing advanced video encoding parameters. See Appendix A, 
section A.3, “Advanced [Video] Button” for more information. 

VIDEO FILE EXTENSION 
When encoding separate audio and video output files, use the Video File Extension 
drop-down list to set the video output file extension: M2V, VBS, MPG, MP2. 

5.4.2 CONFIGURING THE ZAPEX ENCODER PARAMETERS AUDIO TAB 
AUDIO [TAB] 
Controls in the Audio tab are used for configuring the parameters for the audio output file. 

1. Click the Audio tab to bring it to the front. 

2. Configure the audio output parameters. Refer to Figure 5-7. 
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Figure 5-7. Zapex Encoder Parameters Window – Audio Tab 

 

 
MPEG AUDIO BUTTON 
The MPEG Audio button is used to access MPEG Audio encoding parameters. Available 
only if MPEG Audio is the audio Type selected from the Audio Settings. See Appendix C, 
“MPEG Audio Encoding Parameters” for more information. 
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DOLBY DIGITAL BUTTON 
The Dolby Digital button is used to access Dolby® Digital encoding parameters. Available 
only if Dolby Digital is the audio Type selected from the Audio Settings. See Appendix B, 
“Dolby® Digital Encoding Parameters” for more information (only applicable to ZP-330 
encoder models). 

 
AUDIO FILE (APPLICABLE TO ES ENCODING ONLY) 
The Audio File text box is available only if the audio output file is to be captured in a 
different location from video output file. Use this text box for naming and configuring a 
destination path for the audio output file. The destination can be any directory on any local 
hard drive that has enough space. Use the Browse button for selecting existing output 
files if you want to overwrite them. If an Audio File is not specified, the Zapex encoder 
captures the audio output file in the same location as video output file and automatically 
adds: WAV filename extension for PCM audio, MPA for MPEG Audio, or AC3 for Dolby® 
Digital audio. 
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5.4.3 CONFIGURING ZAPEX ENCODER PARAMETERS SYSTEM TAB 
The System tab is the parameter window for PS output format. See Figure 5-8. 

Figure 5-8. Zapex Encoder Parameters Window – System Tab 

 

 
SYSTEM BIT-RATE 
If the Automatically Adjust For Video Bit-Rate check box is selected, ZP-Controller 
calculates the suitable System Bit-rate automatically and the Bit-rate (Mbps) text box 
is not activated. The Mbps text box displays the calculated Bit-rate. 
If the Automatically Adjust For Video Bit-Rate check box is not selected, Bit-rate 
(Mbps) text box becomes active and System Bit-rate can be specified using the slider. 
The Mbps text box displays the Bit-rate value. 
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If the System Bit-rate specified exceeds the minimum requirement, the System 
Information field on the Zapex Encoder Parameters window shows the required 
System Bit-rate. 

 

1. Check the Automatically Adjust For Video Bit-Rate check box or manally set the Bit-rate 
using the slider and the Mbps text box. 

STREAM ID 
Video drop-down list — Stream ID for video stream is specified using this list. The 
range of Stream ID for video is between E0 hex and EF hex. 

Audio drop-down list — Stream ID for MEPG audio is specified using this list. The 
Stream ID range for MPEG audio is between C0 hex and DF hex. Stream ID for Dolby 
Digital is not available. The value is fixed at BD hex. 

2. Set the Stream ID from the Video drop-down list and Video drop-down list. 

3. When you are finished configuring the Zapex Encoder Parameters window – Video, Audio, 
and System tabs, click OK to accept the encoding configuration and return to General 
Settings. 
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5.5 APPLY THE CONFIGURATIONS AND BEGIN ENCODING 
1. From the Export Movie Settings dialog box, click OK to accept and return to the Export 

Movie dialog box. 

2. Click the Save button to begin encoding (Figure 5-9). 

Figure 5-9. Export Movie Dialog Box 

 

3. The Exporting progress indicator appears showing the encoding progress and estimated time 
remaining. 

 

 

Your encoded output file(s) can be found in the path selected in “Selecting A 
Video Project,” and “Configuring The Zapex Encoder Parameters Audio Tab.” 
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66  
BATCH ENCODING 
This chapter contains the following information: 

9 The Batch Encoding Window 
� Starting ZP-Scheduler 
� ZP-Scheduler Menus 
� Project List 
� ZP-Scheduler Buttons 
� Information 

9 Adding and Importing Job Files 
9 Pausing the Batch Process 
9 Removing a Job File 
9 Moving Job Files in the Project List 
9 Saving a Project List 
9 Start Batch-Encoding 
9 Opening a Project List 
9 Editing Job Files 
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6.0 BATCH ENCODING 
This chapter provides information about the batch encoding process. 

6.1 THE BATCH ENCODING WINDOW 
Batch Encoding operates with a group of job files that are encoding sessions and their 
unique parameters. Sequentially encoding these job files (*.ZAP) in real-time is the 
function of the ZP-Scheduler application. Job files are imported into ZP-Scheduler and 
originate in the ZP-Controller section of the Zapex software. Figure 6-1 shows the 
ZP-Scheduler window. 

6.1.1 STARTING ZP-SCHEDULER 
 STARTING ZP-SCHEDULER 

1. Click the Windows’ Start button, click Programs, click ZP-230 or ZP-330, and select 
ZP-Scheduler. 

Figure 6-1. The ZP-Scheduler Window 
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6.1.2 ZP-SCHEDULER MENUS 
FILE  
Saves and opens project files. 

ENCODE MODE 
Encode Mode specifies the starting position of the batch process. 

ABOUT 
The current software version is obtained from this menu. 

6.1.3 PROJECT LIST 
The Project List displays the job number (No.), file name (Job Name), start time-code 
(Start TC), stop time-code (Stop TC), and status of all the job files in the open project. Job 
file numbering determines the encoding sequence. 

6.1.4 ZP-SCHEDULER BUTTONS 
On the right side of the ZP-Controller window are eight buttons.  Refer to Figure 6-1. 

ADD  
The Add button inserts a new Job File at the cursor location in the project file list. 

IMPORT  
Import appends the Project List by inserting a previously saved job file at the cursor 
location.  

PAUSE  
Pauses the batch encoding process.  

REMOVE  
The Remove button deletes the Job file from the Project List.  

CLEAR ALL  
Click Clear All to remove all the Job files listed in the Project List. 

UP AND DOWN  
The Up and Down buttons move the position of the selected Job file up or down in the 
Project list. To reposition the file, select the file and click Up or Down. 

START  
Starts the batch encoding process. 
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6.1.5 INFORMATION 
The Information pane displays status messages during the batch encoding process. 
These messages can be saved in a log file. The Log File resides in the same directory as 
ZP-Scheduler. 

6.2 ADDING AND IMPORTING JOB FILES 
There are two ways to add a Job file to the Project List: Add and Import. Add creates a 
new Job file in the Project List. Import appends existing Job Files to the Project List.  
Added and Imported Job files are appended to the Project list at the cursor location.   

 ADDING A JOB FILE 

The Add button opens ZP-Controller. The Job name text box, Set Job button, and 
Cancel button show up along the lower portion of the ZP-Controller window. The job file 
name is saved automatically when the Set Job button is selected. If you click Cancel, the 
job file is not added to the project list. 

 

 

You can encode using the parameters as configured in the ZP-Controller 
window. Click the Encode button located at the bottom of the window. 

 

1. Click the Add button. This opens ZP-Controller. 

2. Set the encoding parameters. 

 

Batch encoding only supports Time-Code Start/Stop control mode. 

 

3. Enter a job name in the Job name text box, click the Set Job button. Refer to Figure 6-2. 
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The Job name text box always shows the default job file as Job_nnn. 

 

Figure 6-2. ZP-Controller Window — Bottom Portion 

 

 
 IMPORTING A JOB FILE 

1. Click the Import button. 

2. Select the job file you wish to import from the Open File dialog box. 

6.3 PAUSING THE BATCH PROCESS 
The batch encoding process can be paused for content that spans multiple takes. This 
process is described below. 

 INSERTING A PAUSE 

1. Select the location in the Project List where the pause is to be inserted. 

2. Click the Pause button. 

 CONTINUING AFTER A PAUSE 

When the batch process is paused, the following message is displayed: 

“Batch encode is pausing.  Do you begin the next job.  YES or NO” 

YES — continues to the next job. 

NO — asks if you have finished. If you have not finished, you are prompted to begin the next 
job. If you are finished, you are returned to ZP-Scheduler. 
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6.4 REMOVING A JOB FILE 
This function removes the selected job file from the project list. 

 REMOVING A JOB FILE 

1. Select the Job file that is to be deleted from the Project List. 

2. Click the Remove button. 

6.5 MOVING JOB FILES IN THE PROJECT LIST 
Job files are sequentially real-time encoded in the order that they appear in the Project 
List. Job files can be arranged in any order. 

6.6 SAVING A PROJECT LIST 
You can save a batch-encoding session as a file. All of the job files and the sequence is 
saved. To save the Project List select Save from the File menu.  

Job files are temporary files until the project is saved, and are saved in the same directory. 

 

To eliminate the confusion of project specific job names and overwritten job 
files, when saving a project, it is best to save each project to its own project 
directory. 
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6.7 START BATCH-ENCODING 
To start Batch-Encoding click ZP-Scheduler's Start button. The Start button opens the 
Real-Time Encoding window (Figure 6-3) and automatically starts sequential batch 
encoding using the job files that are currently in the project list. 

To stop batch encoding, click the Stop button in the Real-Time Encoding window. 

Figure 6-3. Real-Time Encoding Window 

 

 

6.8 OPENING A PROJECT LIST 
You can open a previously saved project list. To open a project list, select Open from the 
File menu. When a project list is opened a list of all job files in the project are displayed. 
The job files can be edited or you can start encoding. 
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6.9 EDITING JOB FILES 
After a project has been saved, the job files can be modified. Open the project file as 
explained above. Double-click on the job you want to modify. Make your modifications and 
click the Set Job button. 

When a job file is double-clicked in the project list, ZP-Controller re-appears. Any time the 
ZP-Controller window appears, you can reconfigure any of the parameters. Clicking Set 
Job saves the modifications. 
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77  
USING ZP-DECKER 
This chapter contains the following information: 

9 ZP-Decker 
9 The ZP-Decker Window 
9 Starting ZP-Decker 
9 Drag and Drop Features 
9 Main Menu 

� File Menu 
� Time-Code Menu 
� Options Menu 
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7.0 ZP-DECKER 
ZP-Decker is a tool that remotely controls a VTR from your computer. It provides all the 
controls that are common to a VTR. ZP-Decker is installed when the VTR Control Driver 
option is selected during the software installation (see Chapter 2, “Connecting the Media 
Cable and VTR Control Cable” and “Software Installation”). 

7.1 THE ZP-DECKER WINDOW 
Figure 7-1 shows the ZP-Decker window with descriptions of the control functions. 

Figure 7-1. ZP-Decker Window 
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7.2 STARTING ZP-DECKER 
ZP-Decker automatically appears when the ZP-Controller is started. 

7.3 DRAG AND DROP FEATURES 
Using a mouse, the time seen in the Time-Code Display, and the Mark 1 and Mark 2 
Time Code Display can be dragged to the Start and Stop text boxes in ZP-Controller’s 
main window, and to the Time-Code Start and Time-Code/Entry Points text boxes in the 
Advanced Video Settings dialog box. 

7.4 MAIN MENU 
The ZP-Decker has a File, Time-Code, Options, and Help menu. 

7.4.1 FILE MENU 
Use the File menu to exit ZP-Decker. 

7.4.2 TIME-CODE MENU 
Use the Time-Code menu for selecting which time-code format is being supplied by the 
VTR. NTSC Non-drop, NTSC Drop, and PAL can be selected. 

These options are not available while the ZP-Controller application is running. 

7.4.3 OPTIONS MENU 
Use the Options menu for opening the Optional Settings dialog box or for displaying 
context sensitive hints. 

HINTS 
When Hints is selected, hover the mouse pointer above a control and help information 
about that control appears. 
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OPTIONAL SETTINGS DIALOG BOX 
Use the Optional Settings dialog box for configuring Skip and Pre-roll. The middle 
mouse button can be configured to toggle from JOG to SHUTTLE Mode. Refer to 
Figure 7-2.  

Figure 7-2. Optional Settings Dialog Box 

 

 
SKIP/PRE-ROLL 
Use the Seek Time drop-down combo boxes to select the seek time in frames, 
seconds or minutes. 

MIDDLE BUTTON OF MOUSE 
A mouse or pointing device equipped with a middle button can be defined to toggle 
between JOG and SHUTTLE mode. Select the check box to define the middle mouse 
button toggle JOG/SHUTTLE mode. Refer to Figure 7-2. 
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A P P E N D I X  

AA  
ADVANCED VIDEO ENCODING PARAMETERS 
This appendix contains the following information: 

9 Advanced Button (Input) 
� S-Video/Component Video Input 
� Setup Level 
� Video Type 

9 Advanced Button (Video)  
� Generate Time-Code 
� Time-Code Format 
� Start Time-Code 
� Softness Filter 
� NTSC Start Line 
� CCIR 601 Clipping 
� Closed GOP 
� Scene Change Detection (SCD) 
� Splicing Mode 
� Aspect Ratio Flag 
� Entry Points  
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A.0 ADVANCED VIDEO ENCODING PARAMETERS 
The ZP-Controller main window displays Advanced buttons for configuring more 
complicated encoding parameters. This appendix provides information about parameters 
available through these buttons. Some Advanced buttons may not be available for your 
encoder model. 

A.1 ADVANCED BUTTON (INPUT) 
The Advanced [Input] button feature is only available with the CD, CA, and SA encoder 
models. This button opens the Advanced Input dialog box. Use it for configuring the setup 
values of the source video. 

Figure A-1. The Advanced Input Dialog Box 
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A.1.1 S-VIDEO/COMPONENT VIDEO INPUT 
This toggle button is only available on Zapex CA encoder models. From the 
S-Video/Component toggle buttons, select either S-Video or Component Video Input. 

A.1.2 SETUP LEVEL 
The VTR sends the source video that is received by the encoder. One of the video signals 
is the luminance/chrominance signal—the component that contains the video information 
to be encoded. 

The intensity of the luminance/chrominance component is measured on a scale that is 
from black to white. Some videos may have some black removed to lighten the overall 
video image, but some videos may not. Videos produced in the United States commonly 
remove the first 7.5% of the black end of the scale, while in Japan it is more common to 
retain the entire black to white scale. 

SETUP LEVELS 
VALUE DESCRIPTION 

7.5 Source videos having the first 7.5% of the black end of the 
luminance/chrominance scale clipped off. 

0 Source videos using the entire intensity scale (0% removed). 
 

A.1.3 VIDEO TYPE 
This drop-down list appears for Zapex CA and CD encoder models only. There are two 
standards for component video format.  One is Beta, which was defined by Sony. The 
other one is MII, which was defined by Matsushita/JVC. Make sure that the VTR sends 
Beta or MII, and then select the appropriate video type accordingly from the Video Type 
drop-down list. 
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A.2 ADVANCED BUTTON (VIDEO) 
The Advanced [Video] button opens the Advanced Video dialog box (Figure A-2). Use 
this feature to configure specific MPEG-2 encoding parameters. Each parameter is 
described below. 

Figure A-2. Advanced Video Dialog Box 

 

 

A.2.1 GENERATE TIME-CODE 
This check box activates the Start Time-Code parameter and the Time-Code Format 
parameter. Use this check box to embed specific time-code into the stream. If it is not 
selected, the time-code supplied by the VTR is embedded. Whenever manual start is 
selected as the Start/Stop parameter or AVI/WAV File is selected as the Input Frame 
Type, generate time-code is automatically selected (set). 
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A.2.2 TIME-CODE FORMAT 
This drop-down list allows you to select the time-code format to be used on the embedded 
time-code. This configures the time-code to meet the NTSC drop frame type, 29.97 fps, 
NTSC Non-drop frame type, 30 fps, or PAL, 25 fps.  

A.2.3 START TIME-CODE 
The Start Time-Code text box allows you to enter the starting time-code that is 
incorporated into the encoded stream. Enter time-code using the HH:MM:SS:FF 
(hour:minute:second:frame) format. 

A.2.4 SOFTNESS FILTER 
This is a filter that can be incrementally selected for reducing the sharpness of the video 
image: Off, Weak, Medium, and Strong, and Adaptive. If Adaptive is selected, the 
Zapex encoder dynamically changes the type of softness filter per video frame by 
analyzing the characteristic of source video image. 

A.2.5 NTSC START LINE 
This control is available only when the ZP-Controller is in NTSC mode. An NTSC frame 
contains two fields (top and bottom) and 525 video lines. The fields contain the actual 
video content, but are separated by 22 unused lines (not encoded). Both fields provide 486 
lines of video content. 

The encoder automatically crops the top and bottom of the video fields so that the 480 line 
vertical resolution for MPEG-2 video is met. 

If 21 is selected, the encoded portion of each frame is lines 21–523, 22 is 22–524, and 23 
is 23–525. Lines 262–284 that separate the fields are not encoded. 

A.2.6 CCIR 601 CLIPPING 
Video signals consist of luminance and chrominance that have 254 different levels making 
a scale from 1 to 254. The CCIR601 uses the luminance range from 16 (0% black level) to 
235 (100% white level). The chrominance range is from 16–240. However, some video 
source has less than 0% black level and/or more than 100% white level. Use this check 
box for clipping luminance and chrominance of video source to comply with CCIR601 
specification. 
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A.2.7 CLOSED GOP 
Use this check box to encode an MPEG-2 video stream that has a closed GOP structure. If 
this check box is selected, the final picture data of a GOP (group of pictures) and the 
beginning picture data of the GOP that follows do not share the same video data. 

A.2.8 SCENE CHANGE DETECTION (SCD) 
An encoded video stream contains Group of Pictures (GOP) that meets the MPEG-2 
standard. If Scene Change Detection (SCD) is selected, the Zapex encoder automatically 
detects a scene change and starts a new GOP that is a closed GOP. Starting a new GOP 
at the scene change improves video quality. 

A.2.9 SPLICING MODE 
Select this check box to activate the Beginning, Middle, and End buttons. Use splicing 
mode when multiple video tapes must be encoded into a single stream or when a stream 
must be merged with other streams. 

BEGINNING MODE 
This mode encodes an MPEG-2 video stream that is spliced later to another stream, and is 
always located at the beginning of the completed video. 

MIDDLE MODE 
This mode encodes an MPEG-2 video stream that is to be spliced into another stream, and 
is always located at the middle of the completed video. 

END MODE 
This mode encodes an MPEG-2 video stream that that is to be spliced to another stream, 
and is never located at the beginning or middle of the completed video. 

 

Splicing mode works with Elementary Streams only. 

Splicing mode does not encode the last frame of the Beginning and the Middle 
Modes.  To concatenate the spliced files so that they will link properly, using 
the DOS “copy” command, the Middle Start Time-Code will be the same entry 
as the Beginning Stop Time-Code.  In addition, the End Start Time-Code will be 
the same entry as the Middle Stop Time-Code. 

If different tapes (with non-sequential time-codes) are used for the source input 
video, then the option to Generate Time-Code in the Advanced Video dialog box 
should be selected.  This will ensure that the time-code for the final output 
video stream (the concatenated files) will be seamless. 
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SPLICING MODE EXAMPLE 

First Tape Time-Code: 01:00:00:00 to 01:30:00:00 

Second tape Time-Code: 01:30:00:00 to 02:00:00:00 

Third tape Time-Code: 02:00:00:00 to 02:30:00:00 

 

1. Select Beginning in Splicing Mode 

2. Enter the first tape’s timecode in the Start/Stop window 

Start Time-Code: 01:00:00:00 
Stop Time-Code: 01:30:00:00 

3. Start the encoding process 

4. Once first tape encode is complete, switch to second tape 

5. Select Middle in Splicing Mode 

6. Enter the second’s tape’s timecode in the Start/Stop window 

Start Time-Code: 01:30:00:00 
Stop Time-Code: 02:00:00:00 

7. Start the encoding process 

8. Once second tape encode is complete, switch to third tape 

9. Select End in Splicing Mode 

10. Enter the third’s tape’s timecode in the Start/Stop window 

Start Time-Code: 02:00:00:00 
Stop Time-Code: 02:30:00:00 

11. Start the encoding process 

12. Once third tape encode is complete, concatenate files into one file with a 
DOS level “copy” command.  Execute the “copy” command from the 
directory where the video and audio files are stored 

D:\video>  copy  /b  tape1.m2v + tape2.m2v + tape3.m2v  all_tapes.m2v 
D:\audio>  copy  /b  tape1.ac3 + tape2. ac3 + tape3. ac3  all_tapes. ac3 

The concatenated files then may be played as one file using a standard decoder. 
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A.2.10 ASPECT RATIO FLAG 
Use this control to set aspect ratio information in encoded video stream. 16:9 can be used 
to encode a letter-boxed source. 

A.2.11 ENTRY POINTS 
Click Edit to open the Setting Entry Points dialog box. 

 
An encoded video stream contains Group of Pictures (GOP) that meets the MPEG-2 
standard. In this user’s guide, an entry point is defined as the beginning of a GOP. 

Entry points can be used to prepare chapter settings during the DVD authoring process 
with a maximum of 256 entry points. Because entry points start a new GOP, setting an 
entry point at the beginning of a scene change can improve video quality. This involves 
examining the content. 

TIME-CODE 
Use the Time-Code text box for entering a specific time-code for an entry point. Time-
Code can be typed in using the HH:MM:SS:FF (hour:minute:second:frame) format or 
dragged in from ZP-Decker. 

SET 
Opens the Set Time-Code dialog box. It provides an alternative, and sometimes 
faster, method for entering and selecting time-codes. 
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SET TIME-CODE SELECTION OPTIONS 
OPTION DESCRIPTION 

Time-Code Displays the time-code currently selected. 
Get Current T-C If a VTR is connected to the encoder and the VTR Control check box is 

selected in the Properties dialog box (from the Options menu), use this 
button for entering the current time-code (supplied by the VTR) into the 
Time-Code text box. 

History Stores previously used time-codes. As a time saver, double-click a time 
from this list to enter it into the Time-Code text box. 

OK Click this button to accept the time displayed in the Time-Code text box. 

 

ADD 
Click this button to transfer a time-code to the Entry Points list. 

EXTERNAL FILE 
This feature allows you to import and export a text file that lists all entry points. 

IMPORT 
Using a word processor, you can create a text file that lists all the entry points. The 
format is HH:MM:SS:FF where each entry point is on a different line. Click this button 
to select that file. 

EXPORT 
Click this button to save your entry points as a text file. The format is HH:MM:SS:FF 
where each entry point is on a different line. 

ENTRY POINTS 
Shows a list of all the entry points. 

REMOVE 
Select a time-code from the Entry Points list then click this button to remove it. 

CLEAR ALL 
Click this button to delete all entry points from the Entry Points list. 

OK 
Click to apply your entry point list. 
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A P P E N D I X  

BB  
DOLBY® DIGITAL ENCODING PARAMETERS 
This appendix contains the following information: 

9 ZP-330 Dolby® Digital Dialog Box 
9 Audio Service Configuration Tab 

� Audio Coding Mode 
� Channel Assignment 
� Bit Stream Mode 
� Bit-Rate 

9 Processing Tab 
� Dynamic Range Compression Group Box 
� Preprocessing Group Box 

9 Bit Stream Information Tab 
� Dolby® Surround Mode 
� Copyright Bit 
� Original Bit Stream 
� Audio Production Information Group Box 
� Dialog Normalization 
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B.0 DOLBY® DIGITAL ENCODING PARAMETERS 
This appendix provides information about the coding parameters required with Dolby® 
Digital audio. Only the ZP-330 encoder models can encode Dolby® Digital audio. 

B.1 ZP-330 DOLBY® DIGITAL DIALOG BOX 
The Dolby® Digital Parameters dialog box is common to both ZP-Controller and the 
Adobe® Premiere® Plug-in. To view the Dolby® Digital parameters in the ZP-Controller 
main window, click the Advanced [Audio] button to open the Dolby® Digital Parameters 
dialog box. To view the Dolby® Digital parameters in Adobe® Premiere®, select Advanced 
Settings under General Settings in the Export Movie Settings dialog box, click the 
Audio tab to bring it to the front. Click the Dolby® Digital button to open the Dolby® 
Digital Parameters dialog box. 

B.2 AUDIO SERVICE CONFIGURATION TAB 
Figure B-1 shows a detail of the Audio Service Configuration tab. 

Figure B-1. Dolby® Digital Parameters – Audio Service Configuration Tab 
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B.2.1 AUDIO CODING MODE 
The Audio Coding Mode drop-down list configures the number of audio channels to 
encode. 

AUDIO CODE SELECTION OPTIONS 
OPTION DESCRIPTION 
1/0 Mode Encodes an audio source into a Dolby® Digital audio containing a 

monaural center channel. 
2/0 Mode Encodes an audio source into a Dolby® Digital audio containing left and 

right channels. 
 

B.2.2 CHANNEL ASSIGNMENT 
Selects either the Left (L) or Right (R) channel to be encoded for 1/0 Audio Coding Mode. 
Channel Assignment is disabled when the Audio Coding Mode is 2/0. 

B.2.3 BIT STREAM MODE 
Use this parameter to select the type of service that the Dolby Digital (AC-3) bit stream 
conveys. The service types are Complete Main (CM), Music and Effects (ME), Visually 
Impaired (VI), Hearing Impaired (HI), Dialog (D), Commentary (C), Emergency (E), and 
Voice Over (VO)/Karaoke. Most streams use Complete Main. For karaoke, use Voice Over 
(VO)/Karaoke. 

B.2.4 BIT-RATE 
Use this parameter to select a bit-rate to encode. The table shows what bit-rates can be 
used for specific audio coding modes. 

BIT-RATE RANGES 
AUDIO CODING MODE BIT-RATE RANGE 

1/0 (C) 56000 to 640000 bps 
2/0 (L, R) 96000 to 640000 bps 
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B.3 PROCESSING TAB 
Figure B-2 shows a detail of the Processing tab. 

Figure B-2. Dolby® Digital Parameters – Processing Tab 

 

The choices in this tab allow you to adjust the dynamic range compression and 
preprocessing for the Dolby® Digital audio stream. 

B.3.1 DYNAMIC RANGE COMPRESSION GROUP BOX 
COMPRESSION 
Use this parameter to select the type of dynamic range compression for your Dolby® 
Digital (AC-3) bit stream. The types of compression that can be selected are None, Film 
Standard, Film Light, Music Standard, Music Light, Speech. 

RF OVERMODULATION PROTECTION 
Use this parameter to prevent over modulation if heavy compression is needed. Heavy 
compression is targeted for listening situations such as movie delivery to a hotel room, or 
to an airline seat. 

A Dolby® Digital (AC-3) decoder uses the dynamic range compression and RF over-
modulation protection information to reduce the audio program’s dynamic range unless the 
feature is disabled on the decoder by the end user. 
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B.3.2 PREPROCESSING GROUP BOX 
CHANNEL BANDWIDTH LOW-PASS FILTER 
Use this parameter to apply a low-pass filter to the main input channels. The filter cut-off 
frequency is automatically set. 

Since the low-pass filter reduced high frequency signal information, the reduction in signal 
information increases encoding efficiency, achieving better sound quality at lower bit-rates. 

DC FILTER 
Use this parameter to apply a DC filter to all input channels. Since the removal of a DC 
component in source input signal increases the encoding efficiency, the quality of the 
sound increases. 

DIGITAL DE-EMPHASIS 
Use this parameter to apply a digital de-emphasis filter to all input channels. If the source 
audio stream is emphasized, it should be de-emphasized before it is enclosed. 

If Auto is selected, the Zapex encoder automatically detects whether or not the source 
audio stream is emphasized. If the source audio stream is emphasized, the encoder 
automatically activates the digital de-emphasis filter (applicable to DD and CD encoder 
models only). 
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B.4 BIT STREAM INFORMATION TAB 
Figure B-3 shows a detail of the Bit Stream Information tab. 

Figure B-3. Dolby® Digital Parameters – Bit Stream Information Tab 

 

 
Controls in this tab allow you to add data to specific information fields of the Dolby® Digital 
audio stream. 

B.4.1 DOLBY® SURROUND MODE 
Use this parameter to indicate whether or not the Dolby® Digital (AC-3) bit stream is 
conveying a Dolby® Surround encoded program. This parameter is available only using 
Audio Coding Mode 2/0. The parameter can be set to Dolby Surround encoded, Not Dolby 
Surround encoded, or not indicated 

Dolby® Surround Mode information is not used by Dolby® Digital decoders, but may be 
used by Dolby® Surround decoders. 
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B.4.2 COPYRIGHT BIT 
Use this parameter to copyright protect the Dolby® Digital (AC-3) bit stream. 

B.4.3 ORIGINAL BIT STREAM 
Use this parameter to flag the Dolby® Digital (AC-3) bit steam as original material. 

B.4.4 AUDIO PRODUCTION INFORMATION GROUP BOX 
This group of parameters determines whether or not the Dolby® Digital (AC-3) bit stream 
contains mixing level and room type information. Select the Audio Production Info. 
Exists check box to activate the parameters. 

MIXING LEVEL 
Use this parameter to select the acoustic sound pressure level of the dialog during final 
audio mixing.  Values from 0 (80 dB) to 31 (111 dB) can be selected. 

ROOM TYPE 
Use this parameter to select the type and calibration of the mixing room used for the final 
audio mixing. Values of Not Indicated, Large Room, and Small Room can be selected. 

If the source audio is to be encoded for a movie theater, choose Large Room. If the source 
audio is to be encoded for consumer equipment, choose Small Room. If the encoding 
program is unknown, chose not indicated. The Room Type is not typically taken into 
account in Dolby® Digital (AC-3) decoders, but may be used by other audio reproduction 
equipment. 

B.4.5 DIALOG NORMALIZATION 
Use this parameter to select the average dialog sound pressure level. Values from –1 dB 
to –31 dB can be selected 

Be aware that Dolby® Digital (AC-3).decoders automatically adjust the average dialog level 
to –31 dB. For example, if –27 dB is used for dialog normalization, the sound pressure 
level of the dialog will be reduced by 4 dB by the decoder. If 0 dB is used, the sound 
pressure level of the dialog is reduced by 31 dB by the decoder.  If –31 dB is used, the 
sound pressure level of the dialog is not be reduced by the decoder. 
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A P P E N D I X  

CC  
MPEG AUDIO ENCODING PARAMETERS 
This appendix contains the following information: 

9 Basic Parameter Tab 
9 Processing Tab 
9 Header Information 
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C.0 MPEG AUDIO ENCODING PARAMETERS 
This appendix describes MPEG Audio Encoding procedures. These parameters are set 
through the  MPEG Audio Parameters dialog box, which is common to both the ZP-
Controller and the Adobe Premiere Plug-in. To view the MPEG Audio parameters in 
the ZP-Controller main window, click the Advanced [Audio] button. 

To view the MPEG Audio parameters in Adobe Premiere, select Advanced Settings 
under General Settings in the Export Movie Settings dialog box, click the Audio tab to 
bring it to the front, then click the MPEG Audio button to open the MPEG Audio 
Parameters dialog box. 

C.1 BASIC PARAMETER TAB 
The Basic Parameter tab is used to adjust the most fundamental MPEG encoding 
parameters. Figure C-1 shows a detail of the MPEG Audio Parameters dialog box with 
the Basic Parameter tab selected. 

Figure C-1. MPEG Audio Parameters Dialog Box – Basic Parameter Tab 
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The following options table describes the items that can be selected. 

BASIC PARAMETER TAB SELECTION OPTIONS 
OPTION DESCRIPTION 

Coding Mode Use this parameter to configure the channel format and the number of 
audio channels to encode. 
Mode Description 
1/0 single (C) Encodes a center monaural channel 
1+1 dual (Ch1, Ch2) Encodes Ch1 and Ch2 
2/0 stereo (L, R) Encodes left and right channels 

Channel Assignment Selects either the Left (L) or Right (R) channel to be encoded for 1/0 
Coding Mode. 
Select either the Left (L) or Right (R) channel for Ch1 for 1+1 Coding 
Mode. The ZP-Controller automatically assigns the other channel to Ch2. 
Channel Assignment is disabled when the Coding Mode is 2/0. 

Bit-Rate Use this parameter to select a bit-rate for the MPEG Audio bit stream. 
The bit-rates available for specific audio coding modes are: 
Mode Bit-Rate Range 
1/0 single (C) 56000–192300 bps 
1+1 Dual (L/Ch1, R/Ch2) 112300–384000 bps 
2/0 stereo (L, R) 112300–384000 bps 
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C.2 PROCESSING TAB 
Use the processing parameters to optimize the sound qualities of the MPEG audio 
encoding. Figure C-2 shows a detail of the Processing tab. 

Figure C-2. Processing Tab 

 

The following options table describes the items that can be selected. 
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PROCESSING TAB SELECTION OPTIONS 
OPTION DESCRIPTION 

Joint Stereo Use this parameter to activate the dynamic joint stereo coding algorithm. 
Joint Stereo coding utilizes the cross-correlation between left and right 
channel data to provide better sound quality. Higher cross-correlation 
increases sound quality. The increase in sound quality by Joint Stereo 
coding depends on how much left and right channel data are correlated. 
In general, it provides better sound quality for low bit-rates. 
Three modes can be used: 
� Auto The encoder dynamically activates or deactivates Joint 

Stereo coding depending on the characteristics of source 
input signal, sampling frequency, bit-rate, and so on 

� On Joint Stereo coding is always activated 
� Off Joint Stereo coding is always deactivated 

Bandwidth Limiting 
Low-Pass Filter 

Use this parameter to apply a bandwidth limiting low-pass filter to the 
source input signal. The filter cut-off frequency is automatically set 
depending on the sampling frequency, bit-rate, and so on. 
At higher bit-rates (greater than 80,000 bps per channel for 44.1 kHz and 
48 kHz), the filter is not activated. At 32 kHz, the filter is never activated. 
Since the low-pass filter reduces high frequency signal information, the 
reduction in signal information increases encoding efficiency, achieving 
better sound quality at lower bit-rates. 
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C.3 HEADER INFORMATION TAB 
Use the header information parameters to add data to specific information to MPEG Audio 
bit stream fields. Figure C-3 shows a detail of the Header Information tab. 

Figure C-3. Header Information Tab 

 

The following options table describes the items that can be selected. 
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HEADER INFORMATION TAB SELECTION OPTIONS 
OPTION DESCRIPTION 

CRC Use this parameter to activate the CRC check. If selected, CRC check 
word is generated and buried into the MPEG Audio bit stream 

Private Bit This parameter sets the private bit value within the MPEG Audio bit 
stream. 
� If selected, a bit of value “1” is set. 
� If not selected, a bit of value “0” is set. 

Copyright Use this parameter to copyright protect the MPEG Audio bit stream. 
Original Bit Stream Use this parameter to flag the MPEG Audio bit stream as original 

material. 
Emphasis Use this parameter to select the emphasis type of the source input signal. 

If Auto is selected, the encoder automatically detects the emphasis type 
of the source input signal (applicable to DD and CD encoder models 
only). Only three emphasis types are supported: 
� None 
� 50/15 microseconds 
� CCITT J.17 

 



116 ZP-230 & ZP-330 User’s Guide  —  Encoding Solutions for Digital Professionals 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Blank Page] 



117 

A P P E N D I X  

DD  
ADVANCED SYSTEM PARAMETERS 
This appendix contains the following information: 

9 Advanced System Parameters – PS Output Format 
� System Bit-rate 
� Stream ID 

9 Advanced System Parameters – TS Output Format 
� System Bit-rate  
� Program ID(PID) 
� Audio Selection 
� PAT/PMT Interval 
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D.0 ADVANCED SYSTEM PARAMETERS 
This appendix describes advanced system parameters for both PS and TS output formats. 

D.1 ADVANCED SYSTEM PARAMETERS – PS OUTPUT 
FORMAT 

The Advanced button becomes active in the Output group box when either PS or TS 
output format is selected from the drop down list. This button opens the System 
Parameters window. 

Figure D-1 shows the System Parameters window when PS Output Format is selected. 

Figure D-1. Advanced System Parameters — PS Output Format 

 

System 
Bit-Rate 
Slider 

D.1.1 SYSTEM BIT-RATE 
If the Automatically Adjust For Video Bit-Rate check box is selected, ZP-Controller 
calculates the suitable System Bit-rate automatically and the Bit-rate (Mbps) text box 
is not activated. The Mbps text box displays the calculated Bit-rate. 
If the Automatically Adjust For Video Bit-Rate check box is not selected, Bit-rate 
(Mbps) text box becomes active and System Bit-rate can be specified using the slider 
or in the text box. The Mbps text box displays the Bit-rate value.  One of two 
conditions may occur if the bit-rate is changed using this method.  The System Bit-
Rate will either exceed the Specified System Bit-rate or be under the Specified 
System Bit-rate.  The results of these two selections are explained in the following 
paragraphs. 
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If the System Bit-rate specified with the slider exceeds the (calculated) 
Required Bit-Rate, then the System Bit-rate displayed in the System Information 
field of the ZP-Controller main window will be in red text (see Figure D-2). 

Figure D-2. ZP-Controller Window – System Bit-Rate Exceeded 
System
Bit-Rate

shown in
red text.
 

If the Encode button is pressed, a warning message will appear requesting the 
operator if they would like to adjust the video bit-rate? 

 

If the OK button is pressed, the bit-rate will be adjusted by the software and the 
encode process will continue.  Cancel will return the operator to the previous screen. 
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If the System Bit-rate specified with the slider is below the (calculated) 
Required Bit-Rate, then padding bits will be added to the output stream. 

 

Padding bits consist of null bits (zeros) that have been added to the output encode 
Program Stream to keep the stream compliant with MPEG-2 standards. 

 

 

Warning – Certain decoders cannot accept or decode the added padding bits 
with satisfactory results.  When this occurs, the decoder may display distorted 
video that encounters erratic motion and the video may seem unstable. 

 

D.1.2 STREAM ID 
Video drop-down list — Stream ID for video stream is specified using this list. The 
range of Stream ID for video is between E0 hex and EF hex. 

Audio drop-down list — Stream ID for MEPG audio is specified using this list. The 
Stream ID range for MPEG audio is between C0 hex and DF hex. Stream ID for Dolby 
Digital is not selectable. The value is fixed at BD hex. 
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D.2 ADVANCED SYSTEM PARAMETERS – TS OUTPUT 
FORMAT 

The Advanced button becomes active in the Output group box when either PS or TS 
output format is selected from the drop down list. This button opens the System 
Parameters window. 

Figure D-3 shows the System Parameters window when TS Output Format is selected. 

Figure D-3. Advanced System Parameters Windows — TS Output Format 

MULTIPLE AUDIO (AUDIO1 AND AUDIO2) OUTPUT SINGLE AUDIO (AUDIO1) OUTPUT  

  

D.2.1 SYSTEM BIT-RATE 
If the Automatically Adjust For Video Bit-Rate check box is selected, ZP-Controller 
calculates the suitable System Bit-rate automatically and the Bit-rate (Mbps) text box 
is not activated. The Mbps text box displays the calculated Bit-rate. 
If the Automatically Adjust For Video Bit-Rate check box is not selected, Bit-rate 
(Mbps) text box becomes active and System Bit-rate can be specified using the slider 
or the text box. The Mbps text box displays the Bit-rate value. The System Bit-rate 
range is 0.7–12 Mbps.  One of two conditions may occur if the bit-rate is changed 
using this method.  The System Bit-Rate will either exceed the Specified System Bit-
rate or be under the Specified System Bit-rate.  The results of these two selections 
are explained in the following paragraphs. 
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If the System Bit-rate specified with the slider exceeds the (calculated) 
Required Bit-Rate, then the System Bit-rate displayed in the System Information 
field of the ZP-Controller main window will be in red text (see Figure D-4). 

Figure D-4. ZP-Controller Window – System Bit-Rate Exceeded 

 
 
 

System
Bit-Rate

shown in
red text.
 

If the Encode button is pressed, a warning message will appear requesting the 
operator if they would like to adjust the video bit-rate? 

 

If the OK button is pressed, the bit-rate will be adjusted by the software and the 
encode process will continue.  Cancel will return the operator to the previous screen. 
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If the System Bit-rate specified with the slider is below the (calculated) 
Required Bit-Rate, then padding bits will be added to the output stream. 

 

Padding bits consist of null bits (zeros) that have been added to the output encode 
Transport Stream to keep the stream compliant with MPEG-2 standards. 

 

 

Warning – Certain decoders cannot accept or decode the added padding bits 
with satisfactory results.  When this occurs, the decoder may display distorted 
video that encounters erratic motion and the video may seem unstable. 

 

D.2.2 PROGRAM ID(PID) 
The PID decimal value is specified for PMT, Video, Audio1, and Audio2 in the text box 
associated with each type. The PID range is between 16 (10hex) and 8190 (1FFEhex). 

D.2.3 AUDIO SELECTION 
When multiple audio (Audio1 and Audio2) output is selected, a drop-down assignment 
list becomes active. When single audio (Audio1) output is selected, this option is not 
activated. 

D.2.4 PAT/PMT INTERVAL 
The PAT/PMT Interval is specified in this list. Select 1, 2, or 4 times per second. 
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A P P E N D I X  

EE  
REGULATORY APPROVALS 
This appendix contains the following information: 

9 Radio Frequency Interference (RFI) Ratings 
9 FCC Statement 
9 VCCI 
9 CE Statement 
9 ACA Statement 
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E.0 REGULATORY APPROVALS 

E.1 RADIO FREQUENCY INTERFERENCE (RFI) RATINGS 
FCC Part 15 Class A, CE (EN 55022A, EN 50082-1), VCCI Class A, AS3548 Class A 

E.2 FCC STATEMENT 
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15, subpart B, of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his or her own expense. 

Modifications or changes to this product not expressly approved by Zapex Technologies, 
Inc. could void the user’s authority to operate the equipment. 

To insure compliance with FCC non-interference regulations, shielded interface cables 
should be used to attach all peripherals. 

If this equipment does harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 

� Reorient or relocate the receiving antenna. 

� Increase the separation between the equipment and the receiver. 

� Connect the equipment to an outlet on a circuit different from that to which the 
receiver is connected. 

� In case of TV or radio interference, turn the antenna until the interference 
stops, or consider installing an antenna with coaxial cable lead-in between the 
antenna and TV. 

� Consult Zapex Technologies, Inc. technical support. 
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E.3 VCCI 
This is a Class A product based on the standard of the Voluntary Control Council for 
Interference by Information Technology Equipment (VCCI). If this equipment is used in a 
domestic environment, radio disturbance may arise. When such trouble occurs, the user 
may be required to take corrective actions. 

E.4 CE STATEMENT 
Marking by the symbol CE indicates compliance of this device to the EMC directive of the 
European Community. Such marking is indicative that this Zapex system meets or 
exceeds the following technical standards: 

EN 50082-1 
“Electromagnetic compatibility - Generic immunity standard Part 1: Residential, 
Commercial and Light industry.” 

EN 55022 A 
“Limits and Methods of Measurement of Radio Interference Characteristics of Information 
Technology Equipment.” 

E.5 ACA STATEMENT 
This device has been tested and found to comply with the limits for Class A digital device, 
pursuant to the Australian/New Zealand Standard AS/NZS 3548 set out by the Spectrum 
Management Agency. 
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A P P E N D I X  

FF  
PHYSICAL AND ENVIRONMENTAL SPECIFICATIONS 
This appendix contains the following information: 

9 Board 
9 Power 
9 Temperature 
9 Standard EMC 
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F.0 PHYSICAL AND ENVIRONMENTAL SPECIFICATIONS 
The Physical Dimensions and Operating Environment Conditions Summary for the ZP-230 
and ZP-330 MPEG 2 Encoder Families provides physical dimensions, and operating 
environment parameters to Zapex Technologies’ customers. Zapex stipulates that these 
are the accepted environmental parameters for normal board operation.  

F.1 BOARD 
 Dimensions (Main Board) W346.5mmXD126mmXH22mm 

 Mass (Main Board and Interface Card) DD 13.00oz 
CD 13.45oz 
CA 13.45oz 
SA 13.45oz 
NN 10.15oz 

F.2 POWER 
 Distribution on the PCB of 5V 5V ± 0.1V 

 Regulator for Input Voltage from the PC ±5V  ± 5% @ ±12V ± 10% 

 Regulator for Input Voltage to the AIF from 
the Main Board 

±8V  ± 5% @ ±12V ± 10% 

 Maximum Power Current from the PC 5V max 2.9A  
12V max 0.31A 
Max 17.72W 

 DC Voltage 5V ± 5% 
12V ± 10% 
-12V ± 10% 

F.3 TEMPERATURE 
 Operating Temperature +10°C to +40°C (+50°F to 104°F) 

 Operating Humidity 20% to 80% 

 Storage Temperature  -20°C to +50°C  (-4°F to +122°F) 

 Storage Humidity  Less than 90% (non-condensing) 
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F.4 STANDARD EMC 
 FCC FCC Class A 

 VCCI VCCI Class A 

 CE E50082-1 EN55022 Passed 

 UL,CSA Level N/A 

 Electro-static Discharge, Contact 7KV without operating failure 
10KV without system failure 

F.5 PACKAGING 
 Dimensions (Individual Package) W537mmXD232mmXH150mm 

 Mass (Individual Package) DD 4.7lb 
CD 4.8lb 
CA 4.8lb 
SA 4.8lb 
NN 3.5lb 

 Dimensions (Master Package) W543mmXD488mmXH332mm 

 Mass (Master Package) DD 22lb 
CD 23lb 
CA 23lb 
SA 22lb 
NN 18lb 

 Vibration (Packed) 1.5G @ 5-55Hz 

 Drop Packed Surface 1m 
Edge 80cm 
Corner 80cm 
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A P P E N D I X  

GG  
USE OF DOLBY® TRADEMARKS 
This appendix contains the following information: 

9 Introduction 
9 Trademark and Standardization Agreements 

� Who Should Sign the Trademark and Standardization Agreement 
� Licensing Procedure 
� A Note to Replicators and Studios 
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G.0 USE OF DOLBY® TRADEMARKS 
This appendix contains information about the use and licensing of the Dolby® Trademarks. 

G.1 INTRODUCTION 
Dolby® Laboratories owns the trademarks “Dolby®” and the double-D symbol “2,” which 
are registered in over 90 countries in the world. The marks are used on a variety of 
professional noise reduction products, cinema equipment and signal processor 
manufactured and sold by Dolby® Laboratories, Inc. 

Use of the Dolby® Trademarks is licensed to manufacturers of audio and video equipment. 
The appearance of one or more of the trademarks on a licensed product indicates that the 
product contains technology developed by Dolby® Laboratories and that it meets 
performance standards set by Dolby® Laboratories Licensing Corporation (DLLC). 

Use of the Dolby® Trademarks is also licensed to prerecorded audio and video companies 
whose products are made using technology developed by Dolby® Laboratories. The 
appearance of any of the Dolby® Trademarks on prerecorded media indicates that it was 
produced using one or more Dolby® technologies and that it meets performance standards 
set by DLLC. Examples of the Dolby® Trademarks available to licensees for identifying the 
specific technologies used in production and manufacturing are: 

DOLBY TRADEMARK LOGO:  FOR SOUNDTRACKS RECORDED USING: 

1 
 Dolby® Digital (AC-3) audio coding 

4  Dolby® Surround or when the soundtrack have been transferred from a 
Dolby® theatrical release 

6  Dolby® Net audio coding 
  For audio tapes recorded using: 

! (or) s 
 Dolby® B-type noise reduction 

# (or) t  Dolby® S-type noise reduction 

& (or) u  both Dolby® B-type noise reduction and Dolby® HX Pro headroom 
extension 

* (or) v  both Dolby® S-type noise reduction and Dolby® HX Pro headroom 
extension 
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G.2 TRADEMARK AND STANDARDIZATION AGREEMENTS 
Like any material property, a trademark may not be used by others without permission of 
the trademark owner. Also, if a trademark is licensed to others, the trademark owner must 
set quality standards and see that they are adhered to so that the use of the trademarks by 
others does not undermine the good reputation of the marks. In addition to these rather 
straightforward requirements, trademark law also demands that trademarks be used in 
somewhat restricted ways. 

So that it and its licensees can comply with requirements of trademark licensing law, DLLC 
provides Trademark and Standardization Agreements for companies who wish to use the 
Dolby Trademarks on their audio and video media. These Agreements are royalty-free, 
and as a special incentive to promote the use of the Dolby® Surround, Dolby® Digital, and 
Dolby® Net Trademarks, there is currently no processing fee for those trademark licenses. 
All other trademark licenses require a one-time $330 fee for processing the trademark 
license application. This fee is reduced to $250 in the case of audio cassettes 
manufactured by a Dolby® Approved Duplicator. 

A separate Agreement must be signed for each technology prior to use of the 
corresponding Dolby® Trademark. The main points of the Agreements are as follows: 

1. An authorization for the licensee to use the Dolby® Trademarks on prerecorded media 
produced with Dolby® noise reduction and/or Dolby® HX Pro headroom extension, Dolby® 
Surround, Dolby® Digital or Dolby® Net technologies; 

2. Specifications for the correct use of the Dolby® Trademarks and for acknowledging the 
ownership of the marks; 

3. Specifications of the quality control arrangements, which involve the licensee providing 
occasional samples for quality appraisal. 

G.2.1 WHO SHOULD SIGN THE TRADEMARK AND 
STANDARDIZATION AGREEMENT 

A company that owns the rights to a piece of music or other recording, and is involved in 
the preparation, production and sale of prerecorded media incorporating Dolby® 
technology must sign an Agreement if it wishes to use the Dolby® Trademarks on the 
media released under the company's own labels. 

A company which, under contract, simply manufactures prerecorded media for one or 
more customers (Dolby® licensees), and/or is only involved in the preparation of artwork 
(labels, boxes, jackets, insert cards) need not sign an Agreement. 

Responsibility for the quality of recordings and proper trademark usage rests with the 
licensee. 
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G.2.2 LICENSING PROCEDURE 
A company interested in using Dolby® Trademarks on its prerecorded video or audio 
media should contact DLLC for licensing information and to request a license. 

DLLC sends a questionnaire and the appropriate Agreements to licensee for review and 
completion. 

Licensee returns the completed questionnaire, signed Agreements and the appropriate 
processing fee (payable to Dolby® Laboratories Licensing Corporation) to DLLC. In the 
case of tape-based formats such as audio and video cassette, a sample recording must 
also be submitted for quality evaluation. Test samples are acceptable, but only if they are 
manufactured using the same processes and equipment as the product which will 
eventually be distributed to the public. Samples of non-tape formats may be sent later, 
once the final product has been completed. 

DLLC countersigns and returns one copy of each Agreement along with the appropriate 
trademark artwork. 

Subsequent to signing an Agreement, we ask that licensees provide us with sample copies 
of materials which incorporate the Dolby® Trademarks, such as discs, cassettes, insert 
cards, catalogs and advertisements, so that we can verify that our trademarks are being 
used correctly. If licensees have any doubts about correct trademark usage, we ask that 
they please contact us. We are always happy to check drafts of material to be printed or 
used in advertising and promotion, and to give advice on the correct use of our 
trademarks. We may also require the licensee to periodically submit product samples so 
that we may check the soundtrack quality and verify proper trademark use. 

G.2.3 A NOTE TO REPLICATORS AND STUDIOS 
Your clients may not be aware of the fact that a license Agreement with DLLC is required 
before Dolby® Trademarks may be used on their products. Strictly speaking, it is our 
responsibility to provide information to new customers, but we need to know who those 
customers are. Accordingly, if your clients wish to use our trademarks we must rely on 
your cooperation to refer them to us so that licensing formalities can be completed. 

 
Dolby Laboratories Licensing Corporation 
100 Potrero Avenue 
San Francisco, CA 94103-4813 
USA 

Phone: 415-558-0230 
Fax: 415-863-1373 
E-mail: tsa@dolby.com 
http://www.dolby.com 

  
or at  
  
Wooton Bassett 
Wilshire SN4 8QJ 
England 

Phone: 01-793-842100 
Fax: 01-793-842101 
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